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Symantec License and Warranty
IMPORTANT: PLEASE READ THE TERMS AND 
CONDITIONS OF THIS LICENSE AGREEMENT 
CAREFULLY BEFORE USING THE SOFTWARE. 
SYMANTEC CORPORATION AND/OR ITS 
SUBSIDIARIES (“SYMANTEC”) IS WILLING TO 
LICENSE THE SOFTWARE TO YOU AS THE 
INDIVIDUAL, THE COMPANY, OR THE LEGAL ENTITY 
THAT WILL BE UTILIZING THE SOFTWARE 
(REFERENCED BELOW AS “YOU OR YOUR”) ONLY ON 
THE CONDITION THAT YOU ACCEPT ALL OF THE 
TERMS OF THIS LICENSE AGREEMENT. THIS IS A 
LEGAL AND ENFORCEABLE CONTRACT BETWEEN 
YOU AND SYMANTEC. BY OPENING THIS PACKAGE, 
BREAKING THE SEAL, CLICKING ON THE “AGREE” 
OR “YES” BUTTON OR OTHERWISE INDICATING 
ASSENT ELECTRONICALLY, OR LOADING THE 
SOFTWARE, YOU AGREE TO THE TERMS AND 
CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT 
AGREE TO THESE TERMS AND CONDITIONS, CLICK 
ON THE “I DO NOT AGREE”, “NO” BUTTON, OR 
OTHERWISE INDICATE REFUSAL, MAKE NO 
FURTHER USE OF THE SOFTWARE, AND RETURN 
THE FULL PRODUCT WITH PROOF OF PURCHASE TO 
THE DEALER FROM WHOM IT WAS ACQUIRED 
WITHIN SIXTY (60) DAYS OF PURCHASE, AND YOUR 
MONEY WILL BE REFUNDED.

1. License:
The software which accompanies this license 
(collectively the “Software”) is the property of 
Symantec or its licensors and is protected by copyright 
law. While Symantec continues to own the Software, 
you will have certain rights to use the Software after 
your acceptance of this license. This license governs 
any releases, revisions, or enhancements to the 
Software that Symantec may furnish to you. Except as 
may be modified by a Symantec license certificate, 
license coupon, or license key (each a “License 
Module”) which accompanies, precedes, or follows this 
license, your rights and obligations with respect to the 
use of this Software are as follows:

You may:
A. use one copy of the Software on a single computer. 
If a License Module accompanies, precedes, or follows 
this license, you may make that number of copies of 
the Software licensed to you by Symantec as provided 
in your License Module. Your License Module shall 
constitute proof of your right to make such copies.
B. make one copy of the Software for archival 
purposes, or copy the Software onto the hard disk of 
your computer and retain the original for archival 
purposes;
C. use the Software on a network, provided that you 
have a licensed copy of the Software for each computer 
that can access the Software over that network; and
D. after written notice to Symantec, transfer the 
Software on a permanent basis to another person or 
entity, provided that you retain no copies of the 
Software and the transferee agrees to the terms of this 
license.

You may not:
A. copy the printed documentation which accompanies 
the Software; 
B. sublicense, rent or lease any portion of the Software; 
reverse engineer, decompile, disassemble, modify, 
translate, make any attempt to discover the source 
code of the Software, or create derivative works from 
the Software; 
C. use a previous version or copy of the Software after 
you have received a disk replacement set or an 
upgraded version. Upon upgrading the Software, all 
copies of the prior version must be destroyed; 
D. use a later version of the Software than is provided 
herewith unless you have purchased upgrade 
insurance or have otherwise separately acquired the 
right to use such later version;
E. use, if you received the software distributed on 
media containing multiple Symantec products, any 
Symantec software on the media for which you have 
not received a permission in a License Module; or 
F. use the Software in any manner not authorized by 
this license.

2. Content Updates:
Certain Symantec software products utilize content 
that is updated from time to time (antivirus products 
utilize updated virus definitions; content filtering 
products utilize updated URL lists; firewall products 
utilize updated firewall rules; vulnerability 
assessment products utilize updated vulnerability 
data, etc.; collectively, these are referred to as 
“Content Updates”). You may obtain Content Updates 
for any period for which you have purchased a 
subscription for Content Updates for the Software 
(including any subscription included with your 
original purchase of the Software), purchased upgrade 
insurance for the Software, entered into a maintenance 
agreement that includes Content Updates, or 
otherwise separately acquired the right to obtain 
Content Updates. This license does not otherwise 
permit you to obtain and use Content Updates.

3. Sixty Day Money Back Guarantee:
If you are the original licensee of this copy of the 
Software and are dissatisfied with it for any reason, 
you may return the complete product, together with 
your receipt, to Symantec or an authorized dealer, 
postage prepaid, for a full refund at any time during 
the sixty (60) day period following the delivery to you 
of the Software.

4. Limited Warranty:
Symantec warrants that the media on which the 
Software is distributed will be free from defects for a 
period of sixty (60) days from the date of delivery of 
the Software to you. Your sole remedy in the event of a 
breach of this warranty will be that Symantec will, at 
its option, replace any defective media returned to 
Symantec within the warranty period or refund the 
money you paid for the Software. Symantec does not 
warrant that the Software will meet your requirements 



or that operation of the Software will be uninterrupted 
or that the Software will be error-free.
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU 
OF ALL OTHER WARRANTIES, WHETHER EXPRESS 
OR IMPLIED, INCLUDING THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE AND NONINFRINGEMENT 
OF INTELLECTUAL PROPERTY RIGHTS. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. 
YOU MAY HAVE OTHER RIGHTS, WHICH VARY 
FROM STATE TO STATE AND COUNTRY TO 
COUNTRY.

5. Disclaimer of Damages:
SOME STATES AND COUNTRIES, INCLUDING 
MEMBER COUNTRIES OF THE EUROPEAN 
ECONOMIC AREA, DO NOT ALLOW THE LIMITATION 
OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE BELOW 
LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU.
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW AND REGARDLESS OF WHETHER 
ANY REMEDY SET FORTH HEREIN FAILS OF ITS 
ESSENTIAL PURPOSE, IN NO EVENT WILL 
SYMANTEC OR ITS LICENSORS BE LIABLE TO YOU 
FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT OR 
SIMILAR DAMAGES, INCLUDING ANY LOST PROFITS 
OR LOST DATA ARISING OUT OF THE USE OR 
INABILITY TO USE THE SOFTWARE EVEN IF 
SYMANTEC HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.
IN NO CASE SHALL SYMANTEC'S OR ITS LICENSORS’ 
LIABILITY EXCEED THE PURCHASE PRICE FOR THE 
SOFTWARE. The disclaimers and limitations set forth 
above will apply regardless of whether you accept the 
Software.

6. U.S. Government Restricted 
Rights:
RESTRICTED RIGHTS LEGEND. All Symantec products 
and documentation are commercial in nature. The 
software and software documentation are “Commercial 
Items”, as that term is defined in 48 C.F.R. section 
2.101, consisting of “Commercial Computer Software” 
and “Commercial Computer Software Documentation”, 
as such terms are defined in 48 C.F.R. section 252.227-
7014(a)(5) and 48 C.F.R. section 252.227-7014(a)(1), 
and used in 48 C.F.R. section 12.212 and 48 C.F.R. 
section 227.7202, as applicable. Consistent with 48 
C.F.R. section 12.212, 48 C.F.R. section 252.227-7015, 
48 C.F.R. section 227.7202 through 227.7202-4, 48 
C.F.R. section 52.227-14, and other relevant sections 
of the Code of Federal Regulations, as applicable, 
Symantec’s computer software and computer software 
documentation are licensed to United States 
Government end users with only those rights as 
granted to all other end users, according to the terms 
and conditions contained in this license agreement. 
Manufacturer is Symantec Corporation, 20330 
Stevens Creek Blvd., Cupertino, CA 95014.

7. General:
If You are located in North America or Latin America, 
this Agreement will be governed by the laws of the 
State of California, United States of America. 
Otherwise, this Agreement will be governed by the 
laws of England. This Agreement and any related 
License Module is the entire agreement between You 
and Symantec relating to the Software and: (i) 
supersedes all prior or contemporaneous oral or 
written communications, proposals and 
representations with respect to its subject matter; and 
(ii) prevails over any conflicting or additional terms of 
any quote, order, acknowledgment or similar 
communications between the parties. This Agreement 
may only be modified by a License Module or by a 
written document which has been signed by both You 
and Symantec. This Agreement shall terminate upon 
Your breach of any term contained herein and You 
shall cease use of and destroy all copies of the 
Software. The disclaimers of warranties and damages 
and limitations on liability shall survive termination. 
Should you have any questions concerning this 
Agreement, or if you desire to contact Symantec for 
any reason, please write: (i) Symantec Customer 
Service, 555 International Way, Springfield, OR 
97477, USA, or (ii) Symantec Customer Service 
Center, PO BOX 5689, Dublin 15, Ireland. 
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Emergency 

assistance
If you have an emergency, read through these recommendations on what to 
do, and which Norton SystemWorks for Macintosh tool can best solve your 
problem.

Why you should start from the CD

It’s not always best to install Norton SystemWorks if your disk has a 
problem. Do not install the program on a disk that needs repair or contains 
lost files. Installing Norton SystemWorks could destroy the data that you 
want to recover.

See “Before 

installation” on 

page 34.

If you purchased Norton SystemWorks to maintain your Macintosh and do 
not currently have a problem, you can install Norton SystemWorks for 
Macintosh.

w Versions of Norton SystemWorks for Macintosh for both Mac OS 8.1 to 9.x 
and Mac OS X are included on the CD. Features and procedures for both 
versions are similar. However, for specific Mac OS 8.1 to 9.x 
documentation, refer to the PDF on the Norton SystemWorks CD 9 partition 
of the CD.
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What tool should you use for your problem?
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See “Start from the 

CD” on page 17.

If your disk is damaged or contains erased files that you want to recover, 
you can perform the most effective repairs when you restart from the CD. 
When you restart from the CD, you can:

1 View and examine files and folders using DiskViewer from the 
Emergency Launcher. See “Use DiskViewer” on page 20.

1 Choose from a variety of Norton SystemWorks tools from the 
Emergency Launcher. Tools include Norton Disk Doctor, Speed Disk, 
Volume Recover, UnErase, and Wipe Info. See “Explore the Emergency 
Launcher” on page 19.

1 Have Norton Disk Doctor detect and repair problems that can’t be 
fixed if you start normally. See “Examine your startup disk” on 
page 34.

1 Optimize your startup disk. See “Optimize a disk” on page 116.

What tool should you use for your problem?

Each Norton SystemWorks tool helps you solve a specific type of problem. 
Many recommendations include restarting from the CD. For more 
information about the Norton SystemWorks tools and their operating 
environments, see “Protect disks with Norton FileSaver” on page 50. 

Problem Recommendation

Your computer won’t start 
from your normal startup 
disk, 
or 
you see the message, Do 
You Want To Initialize? 
after booting from the CD.

In response to the message, click No or Cancel. 

Restart from the CD and use Norton Disk Doctor to 
examine the disk and repair the damage or rebuild the 
disk’s directory. 

See “Start from the CD” on page 17.

You can also use Volume Recover to repair or recover 
the disk.

See “When to use Volume Recover” on page 92.

If disk damage can’t be repaired, you can still recover 
data with UnErase.

See “Recover files with UnErase” on page 107.

You see a folder with a 
blinking question mark 
(?).

Use Norton Disk Doctor to examine the disk and repair 
the damage. If disk damage can’t be repaired, you can 
still recover data with UnErase. 

See “Recover files with UnErase” on page 107.
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Start from the CD

See “When disks do 

not show up in a 

list” on page 152.

For an emergency situation, start from the CD and use Norton Disk Doctor 
to detect and repair disk problems.

Your disks or files are 
damaged.

Do not install Norton SystemWorks on a disk that you 
want to repair, or from which you want to recover data. 
New files might overwrite the files that you want to 
recover. Use Norton Disk Doctor to examine and repair 
the disk. 

See “When to use Norton Disk Doctor” on page 91.

Your Mac won’t start from 
your normal startup disk.

Restart from the CD.

See “Start from the CD” on page 17.

You accidentally 
reinitialized your hard 
disk.

Use Volume Recover to restore critical information to 
your disk.

See “Maintenance checklist” on page 51. 

Or, if you do not have Norton SystemWorks for 
Macintosh installed, use UnErase.

See “Start from the CD” on page 17.

You accidentally deleted a 
file and emptied the trash. 

Use Unerase or Volume Recover. 

See “Recover files with UnErase” on page 107.

You can’t find a file, or you 
need to rescue files from a 
damaged disk.

Use UnErase or Volume Recover’s Virtual Disk feature 
to recover files. 

See “Identify the preferred recovery method” on page 98.

You need to troubleshoot a 
problem.

See “Troubleshooting computer problems” on page 149.

Problem Recommendation
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To start your computer from the CD

4 Insert your CD into the CD-ROM drive and do one of the following:

2 While restarting your computer, hold down the C key. This will 
automatically open the Emergency Launcher’s Repair Mode 
window. See “What tool should you use for your problem?” on 
page 16.

2 While restarting your computer, hold down the Option key. A 
screen will display with icons that include Norton SystemWorks 
CD X. Select the OS X icon and start your computer from the OS X 
partition of the CD. When startup is complete, the Emergency 
Launcher’s Repair Mode window displays. See “Use DiskViewer” 
on page 20.

2 On the Apple menu, click System Preferences, Startup Disk, 
and then the Norton SystemWorks CD X icon. The Emergency 
Launcher’s Repair Mode window displays. 

w Depending on your computer, you may also be able to select the Mac OS 8.1 
to 9.x version of Norton SystemWorks. This earlier version of Norton 
SystemWorks does not include the Emergency Launcher. 
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Explore the Emergency Launcher

There are tools in the Emergency Launcher’s Repair Mode window that you 
can use when starting from the CD.

DiskViewer Use DiskViewer to see which disks are mounted, and view 
folders and files on those disks. Use it when viewing an 
advance look at a rebuilt disk with Volume Recover to see 
what files have been recovered. From this view you can back 
up files to another disk, such as an external drive. No edits or 
changes can be performed on files from here. 

See “Use DiskViewer” on page 20.

Norton Disk 
Doctor

Finds and repairs disk problems. 

See “When to use Norton Disk Doctor” on page 91.

Speed Disk Check, defragment, or optimize the selected disk. 

See “How Speed Disk optimizes” on page 116.

Volume Recover Perform a FileSaver Search or use Create and View Virtual 
Disk on the selected disk. 

See “When to use Volume Recover” on page 92.

UnErase Perform an UnErase Quick Search and other searches on the 
selected disk. 

See “Recover files with UnErase” on page 107.

Wipe Info Wipe a file, an entire drive, or unused space on the selected 
disk. 

See “When to use Wipe Info” on page 119.

Norton Disk 
Editor

This is a tool that is provided for use by data recovery experts. 
Using this tool is sometimes the only way that damaged files 
or disks can be salvaged or repaired. Do not make 
modifications to your disk using Norton Disk Editor unless 
you are a data recovery expert. 

See “If Norton SystemWorks cannot solve your problems” on 

page 149.
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Use DiskViewer

DiskViewer is used to explore, view, and copy files when you start Norton 
SystemWorks from the CD.

Navigating and viewing files in DiskViewer

DiskViewer displays all your files after you have started Norton 
SystemWorks from the CD.

To navigate through DiskViewer

4 After clicking DiskViewer in the Launcher’s Emergency Mode 
window, do one of the following:

2 Double-click folders and disks.

2 Click the triangles next to folder and disk names.

To get information about a file or folder in DiskViewer

1 Select the file or folder for which you want information. 

2 On the Tasks menu, click Get Info.

To adjust the DiskViewer column widths

4 Drag the divider between any two column headings. 
The entire DiskViewer window can also be resized vertically or 
horizontally. 
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To open a file or folder

4 Do one of the following:

2 Double-click a file name. 

2 Select a file or folder, then on the File menu, click Open 
Selection.

w Opening a file in DiskViewer displays the first 31K of that file in text 
format. The file may not be formatted correctly and you may see 
unrecognizable characters. However, it will help you identify the content of 
the file.

You can have several DiskViewer windows open simultaneously. This 
makes it easy to focus on the content of different folders without having to 
scroll between them.

To open multiple DiskViewer windows

4 Command-double-click a folder in a DiskViewer window to open a new 
window with that folder opened. Each new DiskViewer window will 
have a unique number.

Copying and pasting items to other locations within DiskViewer

DiskViewer allows you to copy and paste files and folders to another 
location within a window or to another DiskViewer window.

To copy and paste files and folders

1 In the DiskViewer window, click an item’s name or hold down the 
Shift key to select multiple items.

2 On the Edit menu, click Copy. 

3 Navigate to another location in the Window, or navigate to a location in 
another DiskViewer window.

4 On the Edit menu, click Paste.

Copying and pasting data from files

DiskViewer allows you to open files and copy text so that you can paste it 
elsewhere.
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To copy text from a file in DiskViewer

1 In the DiskViewer window, double-click a file name or hold down the 
Shift key to select multiple files.
The first 31K of each file selected is displayed. The files may not be 
formatted correctly and you may see unrecognizable characters.

2 Select the desired text, then on the Edit menu, click Copy. 

3 Navigate to another location, then on the Edit menu, click Paste.

After working from the CD

After you have used a Norton SystemWorks tool from the Emergency 
Launcher, you will need to restart your computer. 

To restart after using a tool from the CD

4 Quit Norton Launcher. 
Your computer will automatically restart after a few seconds. If your 
Macintosh does not automatically restart, press Reset or hold the 
Power button for five seconds. 

w Make sure to quit all other Norton SystemWorks programs before you quit 
Norton Launcher when running from the CD. If you are running any other 
programs when you quit Norton Launcher, those programs will be forced to 
quit.

If you can’t start from the CD

See “Explore the 

Symantec support 

Web site” on 

page 54.

The System software included on the CD might not be sufficient to start 
newer Macintosh models issued after the release of this version of 
Norton Utilities. To find out if a newer CD or software is available, contact 
Symantec’s Customer Service.

Why use an earlier version of Norton SystemWorks?

Normally you would boot directly into the OS X version of Norton 
SystemWorks to solve your emergency problems. Like Mac OS 8.1 to 9.x, 
the newer OS X environment provides you with the tools to diagnose, 
repair, and maintain your computer directly from the CD in an emergency 
situation. 

OS X provides additional functionality in the Volume Recover feature, 
letting you create a Virtual Disk to review before rebuilding your 
directories. 
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Some Macintosh models will also allow you to boot into the OS 9 bootable 
partition of the CD. From there, you can run the OS 9 compatible version of 
Norton SystemWorks. There are some advantages to being able to boot into 
the older operating system including: 

1 Access to a Finder 

1 Access to Network Volumes while booted from the CD

w For specific Mac OS 8.1 to 9.x documentation, refer to the PDF on the 
Norton SystemWorks CD 9 partition of the CD.
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Macintosh
w If you have an emergency, do not install Norton SystemWorks yet. 
See “Emergency assistance” on page 15.

See “Installing 

Norton 

SystemWorks for 

Macintosh” on 

page 33.

Whenever you send and receive email, insert a CD or floppy disk, open an 
email attachment, or download a program from a news group or Web site, 
you risk receiving a virus. Norton SystemWorks for Macintosh provides 
comprehensive virus prevention, detection, and elimination for your 
computer. It finds and repairs infected files (files that contain viruses) to 
keep your data safe and secure. 

In addition, there is always the chance that a disk will fail, a file that you 
need will be lost or unreadable, or your Macintosh will not perform the way 
that it should. Norton SystemWorks for Macintosh helps you solve and 
prevent disk problems, repair damaged disks, recover deleted files, and 
optimize hard disk performance. Plus, you are able to keep Norton 
SystemWorks up-to-date over the Internet.

What’s new in Norton SystemWorks for Macintosh

Norton SystemWorks for Macintosh now includes: 

1 Complete antivirus protection of both Mac OS X 10.1.5 and later and 
Mac OS 8.1 to 9.x in one version

1 Quarantine of infected files that cannot be repaired

1 Scan on mount of removable disks including CD, Zip, and floppy which 
further extends the security of your data

1 Tool drawer which allows customized and maximized access to your 
antivirus tools
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1 The Norton QuickMenu from which you can modify Auto-Protect

1 Identification and repair of Windows and DOS viruses in files and 
archives so that hidden PC viruses cannot be planted in your computer 
and spread to Windows computers

1 Scan and repair of files that are inside archives, excluding Stuffit, 
without user prompt

1 Symantec Launcher, a new main window from which you can open all 
Norton SystemWorks tools as well as other Symantec products that are 
installed on your computer

1 An Emergency Launcher that provides a single screen from which to 
select available Norton SystemWorks tools when booting directly from 
the CD

1 A new Virtual Disk feature that lets you view and recover files even 
before you rebuild your directories

1 Optional booting from the CD into Mac OS X or Mac OS 9 for most 
computers, that provides even more repair solutions

1 Improved scheduling options that let you designate when you want the 
Norton FileSaver feature to record data or defragment files, which 
helps to support disk repair and file recovery

1 Increased support and speed for disk repair, recovery, and 
optimization

1 Enhanced file tracking and directory updates

Norton SystemWorks features

Norton SystemWorks for Macintosh combines protection, repair, and 
prevention features. It protects your data from viruses and other malicious 
code. It helps you solve and prevent disk problems, recover deleted files, 
repair damaged disks, and optimize hard disk performance. It also lets you 
keep your virus protection and program components up-to-date over the 
Internet.

About Norton AntiVirus

Norton AntiVirus for Macintosh provides comprehensive virus prevention, 
detection, and elimination software for your computer. It finds and repairs 
infected files (files that contain viruses) to keep your data safe and secure. 
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Norton AntiVirus easily updates its virus definitions over the Internet to 
stay prepared for the latest threats.

How viruses work

A computer virus is a parasitic program written intentionally to alter the 
way your computer operates without your permission or knowledge. A 
virus attaches copies of itself to other files and, when activated, may 
damage files, cause erratic system behavior, or display messages.

Computer viruses infect System files, or files stored in the System folder 
that the Macintosh computer uses to start up and documents created by 
programs with macro capabilities. Mac OS System files include kernel 
extensions (programs that load into memory when a Macintosh computer 
is started), and programs like those in Microsoft Office. 

Some computer viruses are programmed specifically to corrupt programs, 
delete files, or erase your disk. 

Macro viruses spread quickly

Macros are simple programs that are used to do things such as automate 
repetitive tasks in a document or make calculations in a spreadsheet. 
Macros are written in files created by such programs as Microsoft Word 
and Microsoft Excel. 

Macro viruses are malicious macro programs that are designed to replicate 
themselves from file to file and can often destroy or change data. Macro 
viruses can be transferred across platforms and spread whenever you open 
an infected file. 

Trojan horses hide their true purposes

Trojan horses are programs that appear to serve some useful purpose or 
provide entertainment, which encourages you to run them. But the 
program also serves a covert purpose, which may be to damage files or 
place a virus on your computer.

A Trojan horse is not a virus because it does not replicate and spread like a 
virus. Because Trojan horses are not viruses, files that contain them cannot 
be repaired. To ensure the safety of your computer, Norton AntiVirus 
detects Trojan horses so you can delete them from your computer.



About Norton SystemWorks for Macintosh

About Norton AntiVirus
28
Worms take up space

Worms are programs that replicate without infecting other programs. Some 
worms spread by copying themselves from disk to disk. They search for 
specific types of files on a hard disk and try to damage or destroy those 
files. Other worms replicate only in memory, creating myriad copies of 
themselves, all running simultaneously, which slows down the computer. 
Like Trojan horses, worms are not viruses and therefore cannot be repaired. 
They must be deleted from your computer. 

How viruses spread

A virus is inactive until you launch an infected program, start your 
computer from a disk that has infected system files, or open an infected 
document. For example, if a word processing program contains a virus, the 
virus activates when you run the program. Once a virus is in memory, it 
usually infects any program you run, including network programs (if you 
can make changes to network folders or disks).

Viruses behave in different ways. Some viruses stay active in memory until 
you turn off your computer. Other viruses stay active only as long as the 
infected program is running. Turning off your computer or exiting the 
program removes the virus from memory, but does not remove the virus 
from the infected file or disk. That is, if the virus resides in an operating 
system file, the virus activates the next time you start your computer from 
the infected disk. If the virus resides in a program, the virus activates the 
next time you run the program. 

To prevent virus-infected programs from getting onto your computer, scan 
files with Norton AntiVirus before you copy or run them. This includes 
programs you download from news groups or Internet Web sites and any 
email attachments that you receive.

Macintosh computers that are attached to multiplatform networks can 
potentially be affected by Windows-based viruses. If you store Macintosh 
files on network servers accessible by Windows-based computers, those 
files could potentially be attacked by Windows viruses or worms 
programmed to damage files. 
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About Norton Utilities

Unexpected problems can negatively affect the best protected computer. 
The logical structures of your hard disk might become corrupted. You 
might accidentally delete an important file, or an entire folder of important 
files. A crash might erase startup and configuration settings, making your 
computer unusable. Norton Utilities provides the best chance of recovering 
from these problems.

See “Protect disks 

with Norton 

FileSaver” on 

page 50.

Norton FileSaver starts when your computer does and records changes to 
your disks, including file additions and deletions. This information is used 
by UnErase, Norton Disk Doctor, and Volume Recover to facilitate disk and 
file recovery.

Prevent loss and damage of files and documents

Norton Disk Doctor finds and repairs disk problems. Even when your hard 
disk won't restart, you can restart from the CD and use Norton Disk Doctor 
and Norton Disk Navigator to make repairs. See “When to use Norton Disk 
Doctor” on page 91.

Norton FileSaver normally starts when your computer does and saves vital 
disk directory information that UnErase uses to recover lost files. If one of 
your disks becomes damaged, you can use Volume Recover to restore the 
disk using saved FileSaver information. See “How Norton FileSaver 
protects your disks and files” on page 50.

Speed Disk helps to defragment files and free space, and organizes files on 
your disks to provide faster performance. Speed Disk Profile Editor lets you 
customize file arrangements to match your computing activity. See “How 
Speed Disk optimizes” on page 116.

Wipe Info cleans selected files from your disk, preventing the information 
that you have deleted from being seen by anyone else. See “When to use 
Wipe Info” on page 119.

Repair and recover files

Volume Recover works with Norton FileSaver to restore critical information 
to crashed or accidentally erased disks. It also rebuilds directories for 
better chances of data recovery. It provides an advance look at recovered 
directories, which helps to ensure that you are restoring the files that you 
need. See “When to use Volume Recover” on page 92.
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UnErase is used in conjunction with Norton FileSaver. UnErase recovers 
virtually any deleted file or folder, saving you from recreating lost work or 
from searching back up disks for lost files. See “When to use UnErase” on 
page 92.

Norton Disk Editor is a tool provided for use by data recovery experts. 
Using this tool is sometimes the only way that damaged files and disks can 
be salvaged or repaired. Do not make modifications to your disk using 
Norton Disk Editor unless you are a data recovery expert. 

Live Update connects to the Symantec Web site and retrieves program 
updates. See “Update everything now” on page 61.

Norton Scheduler automatically schedules Norton FileSaver, 
Defragmentation, and LiveUpdate events. See “About Norton Scheduler” on 
page 63.

Norton Disk Doctor finds disk problems to prevent emergencies. 
See “When to use Norton Disk Doctor” on page 91.

Wipe Info cleans selected files from your disk, preventing unwanted 
recovery of information that you have deleted. See “How Wipe Info works” 
on page 119.

Is my computer protected now?

See “FileSaver 

snapshots 

schedule” on 

page 51.

Once you have installed Norton SystemWorks and restarted your 
computer, you are safe from viruses. To ensure protection, leave Auto-
Protect on so that the program automatically finds viruses. Use LiveUpdate 
to protect against new viruses. 

See “Maintenance 

checklist” on 

page 51.

It is up to you to maintain your computer's good condition. Keeping Norton 
protection active on your system will help you to ensure your data's safety. 

The virus definition service stops known viruses

See “Look up virus 

definitions on the 

Symantec Web 

site” on page 84.

The virus definition service consists of files that Norton AntiVirus uses to 
recognize viruses and intercept their activity. You can look up virus names 
and access an encyclopedia of virus descriptions on the Symantec Web site. 
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Bloodhound technology stops unknown viruses

Bloodhound is the scanning technology for detecting new and unknown 
viruses. It detects viruses by analyzing an executable file’s structure, 
behavior, and other attributes such as programming logic, computer 
instructions, and any data contained in the file.

Auto-Protect keeps you safe

The Auto-Protect feature loads into memory when your computer starts up, 
and provides constant protection while you work. It eliminates viruses and 
Trojan horses, including macro viruses, and quarantines and repairs 
damaged files. It also checks for viruses every time you use software 
programs on your computer, insert floppy disks or other removable media, 
use the Internet, or copy or save files to your computer.

Norton FileSaver takes snapshots of your data

The Norton FileSaver tool takes its first snapshot of your hard disks within 
five minutes after you restart your computer. FileSaver continues to update 
the snapshot of your disk every 24 hours, or after each time you restart 
your computer. You can also schedule more frequent updates if you choose. 
Other components of Norton SystemWorks use this information to help 
recover after a crash.

About other products on the CD

In addition to Norton Utilities and Norton AntiVirus, there are other tools 
on the Norton SystemWorks for Macintosh CD:

1 Retrospect Express Backup from Dantz: Lets you back up your files 
quickly and easily to a wide range of removable media. 
See “Retrospect Express quick start documentation” on page 125.

1 Aladdin Spring Cleaning: Lets you uninstall old programs and their 
associated files safely and completely, and remove the clutter that is 
left over from your Internet sessions. See “Spring Cleaning quick 
start” on page 130.
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Prepare for emergencies

It is important that you are prepared in case of data loss or if your computer 
is infected by a virus.

In addition to running Norton SystemWorks, do the following:

1 Back up data files regularly. Keep more than just the most recent 
backup.

1 Make sure that you always have the CD or another external device 
from which you can start your computer. See “Start from the CD” on 
page 17.
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w If you have an emergency, do not install Norton SystemWorks yet. 
See “Emergency assistance” on page 15.

Before installing Norton SystemWorks, take a moment to review the 
system requirements listed in this chapter.

Versions of Norton SystemWorks for both Mac OS X and Mac OS 8.1 to 9.x 
are included on the CD. For instructions on installing and using Norton 
SystemWorks for Mac OS 8.1 to 9.x, see the Norton SystemWorks User’s 
Guide PDF in the OS 9 portion of the CD.

System requirements

The following is required to run Norton SystemWorks for Macintosh: 

1 Macintosh OS X 10.1.5 or later

1 Macintosh PowerPC processor, G3 or later 
(Beige G3 and original PowerBook G3 not supported)

1 80 MB of RAM (for Norton SystemWorks)

1 15 MB of RAM (for Aladdin Spring Cleaning)

1 50 MB of RAM (for Dantz Retrospect Express)

1 50 MB of available disk space for installation; 10% of total disk space 
available for optimization

1 Internet connection to download program updates

1 CD-ROM or DVD-ROM drive

w Norton SystemWorks does not support Mac OS X versions 10.0 to 10.1.4, so 
you must upgrade to version 10.1.5 or later.
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Before installation

Before you install Norton SystemWorks:

1 Read the Read Me file for Mac OS X.

1 Start from the CD and examine your startup disk and other mounted 
disks for damage. See “Start from the CD” on page 17.

Examining all mounted volumes ensures that Norton Disk Doctor detects 
any problems before you install.

Read the Read Me file

The Read Me file on the CD contains information that was unavailable at 
the time that the User’s Guide was published. 

To read the Read Me file

1 Insert the CD into your CD-ROM drive.

2 Open the folder for the version of Norton SystemWorks that you are 
installing.

3 Double-click Norton SystemWorks Read Me.

Examine your startup disk

To ensure that your startup disk has no problems, examine it before 
installing Norton SystemWorks.
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To examine your hard disk

See “Start from the 

CD” on page 17.

1 Start your computer using the CD. 

2 In the Norton Emergency Launcher, click Norton Disk Doctor.

3 In the Norton Disk Doctor window, select your startup disk.
If a disk doesn’t appear in the Norton Disk Doctor window, it might be 
damaged. 

See “If Norton Disk 

Doctor finds a 

problem” on 

page 96. 

4 Click Examine. 
If Norton Disk Doctor finds errors during the examination, it prompts 
you to fix or skip the repairs. When the examination is complete, the 
results appear in the Summary window.

5 Click Done.

6 Restart your Macintosh before installing Norton SystemWorks.

Installation

Install the program from the CD.

w Norton SystemWorks for Mac OS X protects both Mac OS X and Mac 
Classic.

The installation procedure requires that you enter an Administrator 
password. If you do not know if your login is an Admin login, you can check 
it in System Preferences.
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To check your login type

1 On the Apple menu, click System Preferences.

2 Do one of the following:

2 In Mac OS X 2.0 and later, click Accounts.

2 In Mac OS X 10.1.5, click Users. 
Your login name and type are listed.

To install Norton SystemWorks

1 Restart your Macintosh before installing Norton SystemWorks.

2 Insert the CD into the CD-ROM drive.
If the CD window doesn’t open automatically, double-click Norton 
SystemWorks CD X.

3 Double-click SystemWorks Install Mac OS X.

4 Double-click the Install Norton SystemWorks icon.

w If you are installing Norton SystemWorks on Mac OS X 10.1.5, the 
Authenticate window does not automatically appear. Click the lock in 
the lower-left corner of the Authorization window to open the 
Authenticate window and continue with the rest of the procedure.
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5 In the Authenticate window, type your Administrator password, then 
click OK.

6 In the Welcome to the Norton SystemWorks Installer window, click 
Continue.
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7 Review the Read Me text, then click Continue.

8 In the Software License Agreement window, click Continue.

9 In the agreement dialog box that appears, click Agree.
If you disagree, you cannot continue with the installation.
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10 Select the disk on which you want to install Norton SystemWorks, then 
click Continue.

11 In the installation type window, do one of the following:

2 For a full installation, click Install. If you have other Symantec 
products installed on your computer, this button may say 
Upgrade.

2 To see a list of components being installed, click Customize.
When you have finished reviewing the list, click Install.

12 In the verification dialog box, click Continue Installation.
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13 Choose whether or not you want to run LiveUpdate to ensure your 
software is up-to-date.

w If you choose not run LiveUpdate now, it should be done at a later time 
to ensure that you have the most recent program updates to Norton 
SystemWorks. 

14 When installation is complete, click Restart.

Why you should restart your computer immediately

“How Norton 

FileSaver protects 

your disks and 

files” on page 50.

When you restart your Macintosh, the Norton FileSaver tool starts working 
by taking its first snapshot of your hard disks within five minutes after you 
restart. Other Norton SystemWorks tools use this snapshot to help you 
recover after a crash.

After installation

Now that you’ve installed Norton SystemWorks, you need to complete the 
following tasks.

Tasks For more information

Make sure you have restarted your computer. See “If you cannot eject 

the CD” on page 41.

Register your software to take advantage of program 
updates and other benefits.

See “Register Norton 

SystemWorks” on page 41.
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If you cannot eject the CD

If you have trouble ejecting the CD after you restart your computer, try one 
of the following:

1 Press the CD-ROM drive’s eject button when your Macintosh restart 
chime sounds.

1 On a newer Macintosh computer with a slot-loading CD-ROM drive, 
press the mouse button while starting up.

Register Norton SystemWorks

Using your existing Internet connection, you can register Norton 
SystemWorks via the Internet. 

Check for late-breaking news and updates about your 
new software. Use the Internet link installed in the 
Norton Solutions folder.

See “For more 

information” on page 52.

Get information about additional features and programs 
that are included on the CD.

See “Explore the CD” on 

page 52.

Make sure that the Norton FileSaver update settings are 
protecting all of your mounted disks.

See “How Norton FileSaver 

protects your disks and 

files” on page 50.

Be sure you have run LiveUpdate to check for the most 
recent program files.

See “When you should 

update” on page 58.

Examine all of your disks to make sure that they are 
problem-free.

See “When to use Norton 

Disk Doctor” on page 91.

Learn more about Norton Disk Doctor examination 
messages.

See “About Norton Disk 

Doctor messages” on 

page 135.

Tasks For more information
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To register via the Internet

See “If you connect 

to the Internet 

through 

America Online” on 

page 43.

1 Connect to the Internet.
If you use America Online (AOL) to connect to the Internet, you need 
to connect to it first.

2 In the Norton Solutions folder, double-click Register Your Software.

Your default Internet browser displays the Symantec support page.

3 On the support page, click I am a home/small business user.

4 On the register your software page, click Norton SystemWorks for 
Macintosh.

5 Select the correct version of the product.

6 Click continue.

7 On the registration page for Norton SystemWorks for Macintosh, type 
all of the required information.

8 Click Submit Registration.
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Read Late Breaking News

Norton SystemWorks for Macintosh installs a Late Breaking News link. Use 
this link to get the latest information for your installed software.

To read Late Breaking News

1 Connect to the Internet.
If you use America Online (AOL) to connect to the Internet, see “If you 
connect to the Internet through America Online” on page 43. 

2 In the Norton SystemWorks for Macintosh folder, double-click Late 
Breaking News.

Your default Internet browser displays the Symantec Late Breaking 
News Web page for your product.

If you connect to the Internet through America Online

If you use America Online (AOL) as your Internet service provider (ISP), 
you must connect to AOL before you go to the Symantec software 
registration page or view the Late Breaking News.

To connect to the Symantec Web site through AOL

1 Log on to AOL.

2 On the AOL Welcome page, click the AOL Internet browser.

3 Move the AOL browser and any other open AOL windows out of the 
way. 

4 In the Norton SystemWorks window, do one of the following:

2 Double-click Register Your Software.
Continue with the registration procedure. See “Register Norton 
SystemWorks” on page 41.

2 Double-click Late Breaking News.
Continue with the procedure for reading the news. See “Read Late 
Breaking News” on page 43.

5 Disconnect from AOL.
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If you need to uninstall Norton SystemWorks

If you need to remove the program from your computer, use the Symantec 
Uninstaller on the CD. The process is faster if all other programs are closed 
before you uninstall the program.

The uninstall procedure requires that you enter an Administrator 
password. If you do not know if your login is an Admin login, you can check 
it in System Preferences.

To check your login type

1 On the Apple menu, click System Preferences.

2 Do one of the following:

2 In Mac OS X 2.0 and later, click Accounts.

2 In Mac OS X 10.1.5, click Users.
Your login name and type are listed.

To uninstall Norton SystemWorks

1 Insert the CD into the CD-ROM drive.
If the CD window doesn’t open automatically, double-click the CD icon 
to open it.

2 In the CD window, open the Install for OS X folder.

3 Double-click Symantec Uninstaller.

4 In the Uninstall Symantec Products window, check the products that 
you want to uninstall.

5 Click Uninstall.

6 Confirm that you want to delete the product.

7 In the Authenticate window, type your Administrator password, then 
click OK.

8 In the window that displays the list of deleted items, click Close.

9 In the Uninstall Symantec Products window, click Quit.
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Norton SystemWorks basics include general information about how to 
work with Norton SystemWorks and how to access more information about 
the tools that are available.

How to start and exit Norton SystemWorks

You don’t have to start the Norton SystemWorks program to be protected 
from viruses if you have Auto-Protect running. You do have to start Norton 
SystemWorks when you want to:

1 Run manual scans of your computer.

1 Schedule Norton AntiVirus to run unattended scans.

1 Customize virus protection options.

The Norton Launcher is a convenient window from which you can launch 
the Symantec products that are installed on your computer. Use Norton 
Launcher to access the features in Norton SystemWorks and any other 
Symantec product that is installed on your Macintosh.

If you’re not certain what a particular tool or program is used for, roll your 
mouse over the icon and a brief description will display at the bottom of 
Norton Launcher.
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Open Norton Launcher

Norton Launcher is installed in the Norton Applications folder.

To open Norton Launcher

4 In the Norton Applications folder, double-click Norton Launcher.

Open a program

Once you have started Norton Launcher, you can open any available 
program.

To open a program from Norton Launcher

1 Open Norton Launcher.

2 In the Norton Launcher window, click an icon.

Customize the Norton Launcher toolbar

You can add any icon to the Norton Launcher toolbar, which is located 
directly above the Launcher. You can also hide or display the toolbar.
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Hide or display the Norton Launcher toolbar

If the Norton Launcher toolbar is hidden, you might have to display it 
before you can customize it.

To hide or display the Norton Launcher toolbar

1 Open Norton Launcher.

2 On the Window menu, select one of the following. Your options are:

Add icons to the Norton Launcher toolbar

You can customize the Norton Launcher toolbar by adding, deleting, or 
rearranging icons.

To add icons to the Norton Launcher toolbar

1 Open Norton Launcher.

2 On the Window menu, click Customize Toolbar.
In the window of available icons, drag an icon to the Norton Launcher 
toolbar.

w You can also add the Norton Launcher to the Dock by dragging its folder 
icon from the Applications folder to the right-hand side of the Dock.

Customize the Norton QuickMenu

The Norton QuickMenu appears as the yellow-and-black Symantec logo on 
the right side of the menu bar. If you do not want the Norton QuickMenu to 
appear on your menu bar, you can hide it. You can also change the items 
that appear on the menu.

To hide the Norton QuickMenu

1 On the Norton QuickMenu, click Norton QuickMenu > Preferences.

2 In the Norton QuickMenu preferences window, uncheck Enable 
Norton QuickMenu.

3 On the System Preferences menu, click Quit System Preferences.

Hide Toolbar Conceals the Norton Launcher toolbar

Show Toolbar Displays the Norton Launcher toolbar
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To show the Norton QuickMenu

1 On the Apple menu, click System Preferences.

2 In the System Preferences window, click Norton QuickMenu.

3 In the Norton QuickMenu preferences window, check Enable Norton 
QuickMenu.

4 On the System Preferences menu, click Quit System Preferences.

To change what appears on the Norton QuickMenu

1 On the Norton QuickMenu, click Norton QuickMenu > Preferences.

2 In the Norton QuickMenu preferences window, uncheck the items that 
you do not want to appear on the menu.

3 On the System Preferences menu, click Quit System Preferences.

Customize your toolbars

Norton SystemWorks lets you customize the toolbars to fit your needs.

The Setup window, Access History log, and Connected Users report all 
have toolbars that you can customize to suit your needs.

To customize your toolbars

1 Open Norton SystemWorks.

2 Open the window with the toolbar that you want to change.

3 On the Window menu, click Customize Toolbar.

4 In the toolbar dialog box, drag the icons into and out of the toolbar at 
the top of the window until you have the set that you want. You can 
change the location in which an icon appears by dragging it to the 
desired location.

5 If you want to return the toolbar to its original appearance, drag the 
default set of icons at the bottom of the dialog box to the toolbar.

6 To change the default icon descriptions, select one of the following:

2 Icon & Text

2 Icon Only

2 Text Only

7 When the toolbar appears the way that you want it, click Done.
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Use Norton SystemWorks shortcuts

You can access Norton SystemWorks tools with various drag-and-drop 
operations. 

Use drag-and-drop operations

Drag a disk or volume icon to any of the following Norton SystemWorks 
program icons.

Enable and disable Norton AntiVirus Auto-Protect

By default, Norton AntiVirus Auto-Protect guards against viruses as soon 
as your computer starts. It checks programs for viruses as they are run and 
monitors your computer for any activity that might indicate the presence of 
a virus. Running a Norton AntiVirus manual scan is not necessary as long 
as Auto-Protect is left on. Auto-Protect interception prevents viruses from 
moving to your disk.

Disable Auto-Protect temporarily

To install some programs, you may need to turn off Auto-Protect.

See “Customize the 

Norton QuickMenu” 

on page 47.

To disable Auto-Protect temporarily

4 On the Norton QuickMenu, click Norton Auto-Protect > Turn Auto-
Protect Off. 

Program icon Result of drag-and-drop operation

Norton Disk Doctor Examine the selected disk.

Speed Disk Check and defragment or optimize the selected disk.

UnErase Perform an UnErase Quick Search on the selected disk.

Wipe Info Wipe unused space on the selected disk.

Volume Recover Perform FileSaver Searches and Create and View 
Virtual Disk on selected disk.

Norton Utilities Open Norton Disk Doctor.

Norton SystemWorks Start Norton Disk Doctor.

Norton AntiVirus Scan a volume, file, or folder for viruses. 
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Protect disks with Norton FileSaver

You are less likely to experience problems with your Macintosh when you 
use Norton SystemWorks for preventive maintenance. Norton FileSaver is 
an important tool used for disk and file recovery.

How Norton FileSaver protects your disks and files

After you install Norton SystemWorks, Norton FileSaver maintains an 
updated record of your startup disk’s directory and files. The first FileSaver 
snapshot is taken five minutes after you restart your computer following 
installation of Norton SystemWorks. It is normally scheduled to take an 
updated snapshot every day at noon, as well as five minutes after each 
restart.

This information is used by UnErase, Norton Disk Doctor, and Volume 
Recover to facilitate disk and file recovery. You can access Norton FileSaver 
and the Scheduler on the Window menu or from the Symantec Launcher. 

Norton FileSaver supports disk repair and file recovery in Norton 
SystemWorks. It works in the background and takes a snapshot of the disk 
directory structure. It saves critical disk and directory structure 
information that Norton Disk Doctor, UnErase, and Volume Recover use to 
restore a disk.

Using the FileSaver window

In the Norton FileSaver window, you can enable or disable the following 
type of activity for each disk:

1 Update Disk Directory Information.

1 Track Deleted Files & Folders.

1 Defragment Files. See “About optimization and file fragmentation” on 
page 115.

w Except for the Defragment Files column, FileSaver default settings have 
each disk and function already selected for best protection. For Defragment 
Files, check the box for the disk that you wish to optimize. See “Optimize a 
disk” on page 116.
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To maintain the FileSaver tool

1 On the Apple menu, click System Preferences.

2 In the System Preferences window, click Norton FileSaver.

3 In the Norton FileSaver window, do any of the following:

2 Check box to update disk and directory information for each disk.

2 Check box to track deleted files and folder for each disk.

2 Check box to defragment each disk according to settings in the 
Norton Scheduler. See “Defragment files” on page 117.

2 Turn FileSaver on or off. Remember that FileSaver will not be 
updating snapshots of your disks, or tracking deleted files, until 
you turn it back on.

FileSaver snapshots schedule

See “Schedule 

FileSaver 

snapshots” on 

page 66.

FileSaver is preset to update disk information daily at noon. To change or 
add to this schedule, use the Norton Scheduler.

Maintenance checklist

With the exception of Norton FileSaver, most Norton SystemWorks tools do 
not run automatically. To maintain your computer’s good condition, 
perform the following tasks regularly.

Task and benefits For more information

Run Norton Disk Doctor for a comprehensive check of 
file-level problems before every back up and before 
running Speed Disk. 

See “When to use Norton 

Disk Doctor” on page 91.

Run Speed Disk any time that you notice your disk 
slowing down. This change in performance can be due to 
excessive fragmentation of files or poor placement of 
files on the disk.

See “How Speed Disk 

optimizes” on page 116.

Keep Norton FileSaver enabled to keep track of your 
files. It also saves critical disk information that can be 
used by Norton Disk Doctor, Volume Recover, and 
UnErase to restore your disk or recover your files.

See “How Norton 

FileSaver protects your 

disks and files” on 

page 50.

Run LiveUpdate to keep your program files up-to-date. 
LiveUpdate downloads and installs the latest program 
updates to ensure that your product is current. 

See “Update procedures” 

on page 60.
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Explore the CD

In addition to the Norton SystemWorks installer and program software, 
there are other items on the CD. 

For more information

Norton SystemWorks provides instructional material in three formats. 

Documentation folder Located inside the Install for Mac OS X folder, this 
Documentation folder contains the User’s Guide in PDF 
format and installation files for Adobe Acrobat Reader. The 
PDF version of the User’s Guide contains additional 
material and details not found in the printed version.

Norton SystemWorks 
for OS 8.1 to 9.x

If you are running Mac OS 8.1 to 9.x you can still use 
Norton SystemWorks. Some computers will allow you to 
run either this version or the Mac OS X version. Other 
computers allow you to only run one or the other. The OS 
8.1 to 9.x version is located on the OS 9 partition of the CD. 

See “Start from the CD” on page 17.

SimpleText 
application

Lets you read the Norton SystemWorks Read Me file in 
Mac OS 8.1 to 9.x folder.

User’s Guide The User’s Guide provides basic conceptual information 
and procedures for using all of the features of Norton 
SystemWorks. Use the printed User’s Guide if you cannot 
access the online material for any reason. Technical terms 
that are italicized in the User’s Guide are defined in the 
glossary, which is available in both the User’s Guide PDF 
and Help.

Built-in Help Help includes all the material contained in the User’s 
Guide, plus expanded conceptual information, procedural 
details, and a glossary for definitions of technical terms. 
Use Help to answer questions while you are using Norton 
SystemWorks.

See “Access Help” on page 53.

PDF The PDF is an electronic version of the User’s Guide that 
you can use if you prefer to look for information online in a 
book-like format or if you want to provide additional copies 
of the User’s Guide. The PDF also includes a glossary for 
definitions of technical terms. 

See “Access the User’s Guide PDF” on page 53.
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In addition to this material, there is a Read Me file on the CD. Check the 
Read Me file before you install Norton SystemWorks for late-breaking 
information.

Finally, you can always check the Symantec Web site for information about 
Norton SystemWorks. You can also use the Web site to subscribe to the 
Symantec Security Response newsletter, which provides you with the 
latest information about virus and other threats and anti-threat technology.

Access Help

Opening Help in Norton SystemWorks displays the Apple Help Viewer 
with a list of Help topics. When you open Help in the Launcher, you find a 
complete list of topics to scroll through that are related to Norton 
SystemWorks. Accessing Help from a specific feature provides a smaller 
list of topics.

To access Help

4 On the Help menu, click Help.

Tips for exploring Help:

1 To search for a specific topic, in the search field at the top of the Help 
window, type the related term, then click Ask.

1 Terms that are underlined and blue in the text are defined in the 
glossary. Click the word to go to its definition. Click the left-arrow 
button to return to the topic.

1 You can view the same information whether you access Help from the 
Launcher or from a specific feature.

1 Links to related topics appear at the end of a topic.

1 Some topics include links that open the window in which you can 
begin the task described.

Access the User’s Guide PDF

The User’s Guide is available in printable Adobe Acrobat PDF format on the 
CD. 

To open the PDF

1 Insert the CD into the CD-ROM drive.

2 In the CD window, double-click the Install for OS X folder.
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3 In the Install for OS X folder, double-click the Documentation folder.

4 Double-click the Norton SystemWorks User Guide PDF.

You can also drag the PDF to your hard disk. 

Tips for exploring the PDF:

1 When you open the PDF, the table of contents appears in the left 
margin. In the table of contents, click a heading to jump to that topic.

1 To search for a specific topic, use the Find command on the Edit menu.

1 Italicized terms in the text are defined in the glossary. Click the word 
to go to its definition. Click Go to Previous View to return to the topic.

Open the Read Me file

The Read Me file contains information that was unavailable at the time that 
the User’s Guide was published. The Read Me file contains information for 
both the Mac OS 8.1 to 9.x and Mac OS X versions of Norton SystemWorks.

To open the Read Me file

1 Insert the CD into the CD-ROM drive.
If the CD window doesn’t open automatically, locate and double-click 
Norton SystemWorks CD X.

2 Double-click Install for Mac OS X.

3 Double-click the Read Me file.

w Additional Read Me files are included in the Applications/Norton 
Solutions/Read Me Files folder. 

Explore the Symantec support Web site

The Symantec support Web site provides extensive information about 
Norton SystemWorks. You can find updates, patches, Knowledge Base 
articles, and virus removal tools.

To explore the Symantec support Web site

1 On the Internet, go to www.symantec.com/techsupp

2 On the support Web page, under home/small business, click 
continue.
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3 On the home computing and small business Web page, click start 
online support.

4 Follow the instructions on the Web site to get the information you 
need.

If you cannot find what you are looking for using the online support pages, 
try searching the Web site.

To search the Symantec support Web site

1 On the left side of any Web page in the Symantec support Web site, 
click search.

2 Type a word or phrase that best represents the information for which 
you are looking. 
For tips on entering your search text, click help at the bottom of the 
page.

3 Check the area of the Web site that you want to search.

4 Click Search.

Subscribe to the Symantec Security Response newsletter

Each month, Symantec publishes a free electronic newsletter that is 
focused on the needs of Internet security customers. It discusses the latest 
antivirus technology produced by Symantec Security Response, common 
viruses, trends in virus workings, virus outbreak warnings, and special 
virus definition releases.

To subscribe to the Symantec Security Response newsletter

1 On the Internet, go to securityresponse.symantec.com

2 On the security response Web page, scroll down to the reference area 
of the page, then click Newsletter.

3 On the security response newsletter Web page, select the language in 
which you want to receive the newsletter.

4 Under Subscribe, type the information requested, then click 
Subscribe.
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Protecting against 
new threats
When you first install your Symantec product and run LiveUpdate, you 
have the most current versions of the product and any protection-related 
files, such as the inappropriate Web site list for Norton Internet Security or 
the virus definitions list for Norton AntiVirus.

At any time, new threats can be introduced. Also, some operating system 
updates may necessitate changes to a program. When these events occur, 
Symantec provides new files to address these issues. You can get these 
new files by using LiveUpdate.

Using your existing Internet connection, LiveUpdate connects to the 
Symantec LiveUpdate server, checks for available updates, then downloads 
and installs them.

About program updates

Program updates are minor improvements to your installed product, 
usually available for download from a Web site. These differ from product 
upgrades, which are newer versions of entire products. Program updates 
that replace sections of existing software are called patches. Patches are 
usually created to ensure the compatibility of a program with new versions 
of operating systems or hardware, adjust a performance issue, or fix bugs.

LiveUpdate automates the process of downloading and installing program 
updates. It locates and downloads files from an Internet site, then installs 
them, and deletes the leftover files from your computer.
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About protection updates

Protection updates are files available from Symantec by subscription, that 
keep your Symantec products up-to-date with the latest antithreat 
technology. The protection updates you receive depend on which products 
you are using.

About your subscription

See “Subscription 

policy” on 

page 162.

If your Symantec product includes protection updates, the purchase of that 
product includes a complimentary, limited-time subscription to the updates 
that are used by your product. When the subscription is due to expire, you 
are prompted to renew your subscription. 

If you do not renew your subscription, you can still use LiveUpdate to 
obtain program updates. However, you cannot obtain protection updates 
and will not be protected against newly discovered threats.

When you should update

See “Schedule 

future updates” on 

page 62.

During installation of your software, you have the option to run LiveUpdate. 
You should do so to ensure that you have the most up-to-date protection 
files. After installation, if you have Norton AntiVirus, Norton Personal 
Firewall, Norton Internet Security, or Norton SystemWorks installed, 
update at least once a month to ensure that you have the latest virus 
definitions and firewall protection.

Before updating

In some cases there are preparations you must make before running 
LiveUpdate. For example, if you use America Online (AOL) as your Internet 
service provider (ISP), you must log on to AOL before you use LiveUpdate.

Norton AntiVirus, 
Norton SystemWorks

Users of Norton AntiVirus and Norton SystemWorks 
receive virus definition service updates, which provide 
access to the latest virus signatures and other technology 
from Symantec.

Norton Internet 
Security

In addition to the virus definition service, users of Norton 
Internet Security receive protection updates to the lists of 
Web site addresses and Web site categories that are used 
to identify inappropriate Web content.
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If you use America Online to connect

If you use America Online (AOL) as your Internet service provider (ISP), you 
need to log on to AOL before you use LiveUpdate.

To use LiveUpdate with AOL

1 Log on to AOL.

2 On the AOL Welcome page, click the AOL Internet browser.

3 Open LiveUpdate.

4 Follow the instructions in “Update procedures” on page 60.

5 When the LiveUpdate session is complete, close your AOL browser.
If your LiveUpdate session requires that you restart your computer, 
disconnect from AOL before restarting.

If you update on an internal network

If you run LiveUpdate on a Macintosh that is connected to a network that is 
within a company firewall, your network administrator might set up an 
internal LiveUpdate server on your network. Once your administrator has 
configured it, LiveUpdate should find this location automatically.

If you have trouble connecting to an internal LiveUpdate server, contact 
your network administrator.

If you can’t use LiveUpdate

When new updates become available, Symantec posts them on the 
Symantec Web site. If you can’t run LiveUpdate, you can obtain new update 
files from the Symantec Web site.

w Your subscription must be current to obtain new protection updates from 
the Symantec Web site.

To obtain virus definitions from the Symantec Web site

1 Start your Internet browser and go to the following site:
securityresponse.symantec.com/avcenter/defs.download.html
If this page doesn’t load, go to securityresponse.symantec.com and 
click Download Virus Definitions, then click Download Virus 
Definitions (Intelligent Updater Only).

2 On the security response page, select Norton AntiVirus for 
Macintosh.
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3 Click Download Updates.

4 On the security response page, select the file to download. 
Be sure to select files for the appropriate version of your product.
Information about the update is included with the download.

To obtain product updates from the Symantec Web site

1 Open your Internet browser and go to the following site:
securityresponse.symantec.com/downloads/

2 On the downloads page, in the product updates list, select the product 
for which you want an update.

3 On the support page, select the version of the product.

4 Click continue.

5 On the product page, select the file to download.
Information about the update is included with the download.

Update procedures

See “Schedule 

future updates” on 

page 62.

You can have LiveUpdate look for all updates at once, or select individual 
items to update. You can also schedule a future LiveUpdate session. 

Select items to 

update during this 

session

Updates all installed 

components

Indicates the last 

update activity

Lets you schedule 

specific updates
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Update everything now

Updating all available files is the fastest method to ensure the latest 
protection for all your Symantec products. 

To update everything now

1 On the Norton Launcher menu bar, click LiveUpdate.

2 Click Update Everything Now.
A status dialog box keeps you informed of the file transfer process.

Customize a LiveUpdate session

If you want to update only one or two items, you can select them and omit 
items that you don’t want to update.

To customize a LiveUpdate session

1 In the LiveUpdate window, click Customize this Update Session.
LiveUpdate presents a list of available updates. By default, all are 
checked for inclusion in this update session. If your files are already 
up-to-date, no items are available for selection.

2 Uncheck the items that you don’t want to update. 

See “View the 

LiveUpdate 

Summary” on 

page 61.

3 Click Update.
The file transfer takes a few minutes. When it is complete, the 
LiveUpdate summary window appears. 

After updating

When a LiveUpdate session is complete, the LiveUpdate Summary window 
displays a list of what was updated, along with brief notes. 

View the LiveUpdate Summary

The LiveUpdate Summary dialog box displays a summary of the activity 
and a list of products updated in this session.

Some updates require that you restart your computer. When this 
recommendation appears in the summary description, the Restart button is 
available.

To restart after a LiveUpdate session

4 In the LiveUpdate Summary window, click Restart.



Protecting against new threats

Schedule future updates
62
Empty the Trash after a LiveUpdate session

After you update program files, LiveUpdate moves the older, discarded files 
to the Trash. If you haven’t already restarted after updating, you might get 
a message that these files are in use. After you restart your computer, you 
can empty the Trash.

Check product version numbers and dates

The LiveUpdate window displays the version numbers and dates of the 
most recent updates. 

You can also check the version numbers and dates in the product’s About 
box, accessible from the product menu, to verify that you have the latest 
version.

To view an application’s About box

1 Open your product.

2 On the product menu, click About <product name>.
The About box lists the version number and copyright dates.

3 When you’ve finished viewing the About box, close it.

Schedule future updates

w The user who scheduled the event must be logged on for the scheduled 
event to occur. If this condition is not true, the event occurs the next time 
the correct user is logged on.

You can set up events to run at a scheduled time, without your 
participation. If your Macintosh is turned off during the time an event 
should take place, the event occurs the next time that you start your 
Macintosh. Before scheduling an update, test it once manually. See “Update 
everything now” on page 61, and “Customize a LiveUpdate session” on 
page 61.

For instructions on scheduling future updates, see “Schedule LiveUpdate 
events” on page 64.



Scheduling future 
events
Use Norton Scheduler to ensure that key tasks are performed regularly to 
keep your computer and data protected.

About Norton Scheduler

The tasks that are available in Norton Scheduler depend on what products 
are installed.

If your Macintosh is turned off during the time that an event should take 
place, the event occurs the next time that you start your Macintosh.

Open Norton Scheduler

You can open Norton Scheduler from your open program.

To open Norton Scheduler from LiveUpdate

See “Update 

procedures” on 

page 60.

1 Open LiveUpdate.

2 In the LiveUpdate window, click Norton Scheduler.

See “How to start 

and exit Norton 

SystemWorks” on 

page 45.

To open Norton Scheduler from the Norton Launcher

1 Open Norton Launcher.

2 On the Norton Launcher window, click Norton Scheduler.

To open Norton Scheduler from Norton FileSaver

1 Open Norton FileSaver.

2 In the Norton FileSaver window, click Norton Scheduler.
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To open Norton Scheduler from Speed Disk

See “Open Speed 

Disk” on page 116.

1 Open Speed Disk.

2 On the Utilities menu, click Norton Scheduler.

Schedule LiveUpdate events

In Norton Scheduler, LiveUpdate events check for updates to your installed 
products. If you have Norton AntiVirus installed, a monthly virus definitions 
update is also scheduled.

To add scheduled LiveUpdate events

See “Open Norton 

Scheduler” on 

page 63.

1 Open Norton Scheduler.

2 In the Norton Scheduler window, click New.

3 Click Product Update.

4 Type a descriptive name for the LiveUpdate task, for example, Update 
Fridays.

5 In the Choose a product to update list, select the item to update. Your 
options are:

6 In the Set a Frequency list, specify when the update should occur. 
Your options are:

All Products Updates all installed products.

Virus Definitions Updates virus definitions.

LiveUpdate Updates LiveUpdate program files.

<Product Name> Updates a product that you select. The names of 
installed Symantec products appear in the list.

Monthly Runs the event monthly on the indicated date and 
time. You can select a date from the first of the month 
to the twenty-eighth.

Weekly Updates once a week on the specified day and at the 
specified time.

Daily Runs the event daily at the indicated time.

Annually Runs the event each year on the indicated day and 
time. You can schedule the event up to one year in 
advance.
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7 If you choose a frequency other than Daily, specify the date or day of 
the week that the update should occur.

See “Set a start 

time” on page 66.

8 Set a start time for the event.

9 Click Save.

Schedule Norton AntiVirus scans

If you have Norton AntiVirus installed, you can add scheduled scans of all 
or a part of your computer. 

To add scheduled Norton AntiVirus scans

See “Open Norton 

Scheduler” on 

page 63.

1 Open Norton Scheduler.

2 In the Norton Scheduler window, click New.

3 Click AntiVirus Scan.

4 In the Add AntiVirus Scan Task window, type a descriptive name for 
the task, for example, Scan OS X disk.

5 Do one of the following:

2 Drag the item you want to scan from the Finder into the Add 
AntiVirus Scan Task window.

See “Select an item 

for a scheduled 

scan” on page 66.

2 Click Browse to select the item you want to scan.

6 In the Set a Frequency list, specify when the scan should occur. 
Your options are:

7 If you choose a frequency other than Daily, specify the date or day of 
the week that the scan should occur.

See “Set a start 

time” on page 66.

8 Set the time of day that the event should occur.

9 Click Save.

Monthly Runs the event monthly on the indicated date and 
time. You can select a date from the first of the month 
to the twenty-eighth.

Weekly Updates once a week on the specified day and at the 
specified time.

Daily Runs the event daily at the indicated time.

Annually Runs the event each year on the indicated day and 
time. You can schedule the event up to one year in 
advance.
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Select an item for a scheduled scan

You can select a disk, volume, folder, or file to scan.

To select an item to scan

1 In the Add AntiVirus Scan Task window, click Browse.

2 In the Select a scan target window, locate the disk, volume, folder, or 
file.

3 Click Select.

4 The item’s name and location appear in the Add AntiVirus Scan Task 
window.

Set a start time

You can set the exact time at which you want a scheduled event to start.

To set a start time

1 In the task window, in the Set the time box, do one of the following:

2 Type the exact time that you want in the hour and minute boxes.

2 Select the hour or minute box, then click the Up Arrow or Down 
Arrow to change the time that is displayed.

2 If your computer is set to display a 12-hour clock, an AM/PM indicator 
appears next to the time. Click the indicator to toggle the setting.

3 When you are finished, click Save.

Schedule FileSaver snapshots

See “FileSaver 

snapshots 

schedule” on 

page 51.

You can add scheduled FileSaver snapshots. The FileSaver update schedule 
is preset to update disk information daily at noon. If you have Norton 
FileSaver installed, you can schedule an event from the Norton FileSaver 
window.

To add scheduled FileSaver snapshots

1 Open Norton Scheduler.

2 In the Norton Scheduler window, click New.

3 Under Choose a task for scheduling, click FileSaver Snapshot.

4 In the Add FileSaver Snapshot Task window, type a descriptive name 
for the task, for example, Update Fridays.
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5 In the Set a Frequency list, specify when the task should occur. Your 
options are:

6 If you choose a frequency other than Daily, specify the date or day of 
the week that the task should occur.

7 Set the time of day that the event should occur.

8 Click Save.

Schedule disk defragmentation

You can schedule a task for Speed Disk to defragment the disk or disks you 
have selected in FileSaver preferences. The disk defragmentation schedule 
is preset to run at midnight.

w Use Speed Disk to optimize any disk before you schedule it for 
defragmentation.

To add scheduled defragmentation

1 Open Norton Scheduler.

2 In the Norton Scheduler window, click New.

3 Click Defragment Files.

4 In the task window, type a descriptive name for the task, for example, 
Defrag Fridays.

Monthly Runs the event monthly on the indicated date and 
time. You can select a date from the first of the month 
to the twenty-eighth.

Weekly Runs once a week on the specified day and at the 
specified time.

Daily Runs the event daily at the indicated time.

Annually Runs the event each year on the indicated day and 
time. You can schedule the event up to one year in 
advance.
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5 In the Set a Frequency list, specify when the update should occur. Your 
options are:

6 If you choose a frequency other than Daily, specify the date or day of 
the week that the task should occur.

7 Set the time of day that the event should occur.

8 Click Save.

Manage scheduled events

You can edit, delete, disable, and reset scheduled events.

Edit scheduled events

You can make changes to the events that you schedule.

To edit a scheduled event

1 Open Norton Scheduler.

2 In the Scheduled Events list, select the scheduled event that you want 
to change.

3 Click Edit.

4 Make your changes.
For a description of the scheduling options, see “Schedule LiveUpdate 
events” on page 64.

5 To change the event name, type a new name in the name field.

6 Click Save.

Monthly Runs the event monthly on the indicated date and 
time. You can select a date from the first of the month 
to the twenty-eighth.

Weekly Updates once a week on the specified day and at the 
specified time.

Daily Runs the event daily at the indicated time.

Annually Runs the event each year on the indicated day and 
time. You can schedule the event up to one year in 
advance.
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Delete scheduled events

You can delete scheduled events that you no longer want.

To delete a scheduled event

1 Open Norton Scheduler.

2 In the Scheduled Events list, select the scheduled event that you want 
to delete.

3 Click Delete.

4 In the verification box that appears, click Delete to verify that you 
want to delete the event.

Disable scheduled events

You can disable scheduled events without deleting them in case you want 
to enable them later.

To disable a scheduled event

1 In the Scheduled Events list, under On, uncheck the event that you 
want to disable.

2 To enable the event, check it again.

Reset scheduled tasks

You can reset all scheduled tasks to their original installed settings.

Product Installed settings

Norton Personal Firewall None.

Norton AntiVirus Monthly LiveUpdate task to check for new virus 
definitions. Set to run on the first of each month.

Norton Internet Security Monthly LiveUpdate task to check for new virus 
definitions. Set to run on the first of each month.
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To reset scheduled tasks

1 On the Norton Scheduler menu, click Reset Scheduled Tasks.

2 In the verification window, click Reset.

Norton Utilities Daily FileSaver snapshot to update your disk directory 
information. Set to run at noon.

Daily Speed Disk defragmentation. Set to run at 
midnight.

Norton SystemWorks Monthly LiveUpdate task to check for new virus 
definitions. Set to run on the first of each month.

Daily Speed Disk defragmentation. Set to run at 
midnight.

Daily FileSaver snapshot to update your disk directory 
information. Set to run at noon.

Product Installed settings
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Protecting disks, 
files, and data from 
viruses
Although Norton AntiVirus Auto-Protect monitors your computer for 
viruses by scanning files when they are created or copied, and scanning all 
disks and removable media when they are mounted, Auto-Protect might not 
catch new viruses. With Norton AntiVirus you can scan any file, folder, or 
disk for viruses.

Scan disks, folders, and files

Start the Norton AntiVirus main program to scan your disks. 

Norton AntiVirus can scan only those files to which you have access 
permission. Even if you are logged on as an administrator, there are certain 
system files and directories that cannot be scanned. Those files can be 
scanned only if you are logged on with root access. However, unless you log 
on as root when you work on your computer, there is almost no chance that 
those files could be infected, as Mac OS X is set by default to have the root 
account disabled. If you never log on as root, performing scans while logged 
on as an administrator catches any viruses the computer might have 
acquired. 

You can customize the way Norton AntiVirus performs scans. Norton 
AntiVirus can check compressed files for viruses, but not encrypted files. 
Encrypted files, which normally require a password to open them, must be 
decrypted before you scan them. 
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To scan disks, folders, and files for viruses 

1 Open Norton AntiVirus.

2 In the Norton AntiVirus main window, do one of the following:

2 In Disk View, select the disk to scan.

2 In File View, select individual folders or files to scan.

3 Click Scan/Repair.

4 Click Pause to interrupt a scan. 
To resume the scan, click Continue.

5 To view details of a selected file, look in the Scan Results pane.

6 To view details of a selected file, look in the File Info panel.
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If problems are found during a scan

Norton AntiVirus is designed to help keep your computer virus-free. In 
most cases, an infected file can be repaired automatically. In some cases, 
you may need to take further action.

In Mac OS X, the file is automatically repaired if you have Automatic Repair 
On checked on the General tab of the Preferences window.

If the virus is not repaired, the file can be quarantined. Quarantining a file 
prevents it from reinfecting your computer or damaging other files. 

Scan email attachments

See “Set Scan 

Preferences” on 

page 87.

Norton AntiVirus Auto-Protect provides automatic scanning of email 
messages. With Auto-Protect enabled and Scan compressed files turned on, 
scanning of email is fully functional.

Scan and repair in archives

The Norton AntiVirus application automatically scans and repairs inside 
file archives. For example, if you open a zip file Norton AntiVirus scans 
and, if needed, repairs files without user action.

w Scanning of Stuffit file Archives is limited to the Norton AntiVirus 
application. Auto-Protect, the command line scanner, Scan on Mount, and 
scheduled scanning do not scan within Stuffit Archives. All other 
compressed and archival file formats are scanned. 

View and print scan history

Norton AntiVirus automatically saves a report of each scan. You can view 
and print these scan results at the end of a scan. You can also review 
previous scans in the History file.

Save and print scan reports

At the end of a scan, you can save the scan results in a file. You can specify 
the file format in Preferences. Saving a scan report in a specific file format 
associates it to a word processing program. You can print a scan report 
from the Scan Results window or from the Scan History window.
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To select a scan report to save or print

1 In the Norton AntiVirus main window, click View History.

2 In the Norton AntiVirus Scan History window, in the top pane, select 
the report to view.
The details appear in the lower pane of the window.

To save the selected scan report

1 On the File menu, click Save Report As.

2 In the dialog box that appears, specify a name and location for the file. 
The default file name is <Untitled Report>.

3 Click Save.
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To print the selected scan report

1 Do one of the following:

2 If you are still viewing the scan results, click Print.

2 If you have selected the report in the Scan History window, on the 
File menu, click Print. 

2 In the Print dialog box, select the printing options for the report.

3 Click Print.

Perform a scan from the command line

Use the Command Line Scanner to run scans from the command line and to 
obtain scan reports and save them. Create scripts to be incorporated into 
other UNIX maintenance scripts.

You can customize the features of the Command Line Scanner to run the 
scans that you want. Here are a few examples of command line scans you 
can run:

1 navx /
Scans your system drive with default options

1 navx -a -r /Users/steve/
Scans without repairing, the files in the home folder of user steve, and 
report the status of all files

1 navx -ar /Users/steve/
Scans without repairing, the files in the home folder of user steve, and 
report the status of all files

1 navx -o ~/myReportFile /tmp
Scans the files in /tmp, and stores the report in your home folder

1 navx -a -o ~/myReportFile /tmp > <filename.log>
Scans the files in /tmp, and stores the complete report in your home 
folder, and in a log
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To scan a file using the Command Line Scanner

1 Open Terminal.

2 At the prompt, type navx.

3 Type the command you want. Your options are:

4 Type the name of the file you want to scan.

5 Press Enter. 

-a Reports all files scanned regardless of damage or threat.

-c Scans inside of compressed files.

-f Forces the scan to run even if the output file specified with 
-o cannot be created or opened.

-h Reports on files that were inaccessible for scanning.

-Q Quarantines files that can’t be repaired.

-r Does not repair files with defined threats.

-v Displays the version number. 

-o <output 
filename>

Output appends to the file <output filename>. If -Q is also 
selected, only the summary appears on the screen, but the 
full report is appended to <output filename>.
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is found
If Norton AntiVirus reports a problem follow the instructions provided for 
that specific problem.

The message may not be discussed in this chapter. For more information 
about other messages, see “Troubleshooting computer problems” on 
page 149.

Auto-Protect finds a virus

Norton AntiVirus Auto-Protect guards against viruses as soon as your 
computer starts. It checks programs for viruses as they are run and 
monitors your computer for any activity that might indicate the presence of 
a virus. Auto-Protect alerts you to any virus activity.

By default, Auto-Protect is turned on. With default settings, Auto-Protect 
automatically repairs files or quarantines irreparable files. 

When a virus is found while Norton AntiVirus Auto-Protect is running, an 
alert displays what happened and what your options are. Read the message 
carefully to determine whether you need to do anything.
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Auto-Protect finds a virus and repairs the file

When Norton AntiVirus Auto-Protect reports that it repaired an infected 
file, you don’t have to do anything.

Even when Auto-Protect has repaired the infected file, ensure that no other 
viruses exist on your computer by scanning with Norton AntiVirus.

Auto-Protect finds a virus but does not repair the file

See “About User 

Preferences” on 

page 86.

If you have set the Auto-Repair Scan preference to Manually repair infected 
files, Auto-Protect informs you of infected files, but does not repair them.

To manually repair an infected file that has been detected but not 

repaired

1 Read the entire message.
Look for words that identify the type of problem. 

2 Click Yes.
If the file cannot be repaired it is automatically quarantined. For more 
information about quarantine settings, see “About User Preferences” 
on page 86.

3 Click OK. 
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Auto-Protect finds a virus and cannot repair the file

In a few cases, Auto-Protect may not be able to repair or quarantine an 
infected file, whether or not you have preferences set to Automatic Repair. 

To delete an infected file that has been detected but cannot be 

repaired

See “Scan disks, 

folders, and files” 

on page 73.

4 Click Yes to run Norton AntiVirus and scan the file or folder 
containing the virus. 
In the scan window, you can view more details about the infected file. 
See “If Norton AntiVirus can’t repair a file” on page 82.

A virus is found when removable media is inserted

If Auto-Protect finds a virus when removable media is connected to your 
computer, an alert displays what happened and what your options are. See 
“Auto-Protect finds a virus” on page 79 and “A virus is found during a user-
initiated scan” on page 81.

Repair, Delete, and Restore in Quarantine

After files have been quarantined you can try to repair, delete, or restore 
the file. 

A virus is found during a user-initiated scan

If you are scanning with Norton AntiVirus and a virus is found, a Problem 
found alert appears in the scan window. Usually, infected files are repaired 
or quarantined automatically and you don’t have to do anything else. To 
determine if the file was repaired or if you need to take further action, 
check the status of the file in the scan window.
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To check the status of infected files in the scan window

4 In the Virus Scan window, under Scan Results, select the infected file.

Repair infected files 

If an infected file in the scan window was not repaired because Auto-Repair 
was turned off in Preferences and you have Quarantine files that cannot be 
repaired unchecked, initiate the repair yourself.

To repair infected files

1 In the scan results list, select the files to repair.

2 Click Repair.

3 After repairing all infected files, scan your disks again to verify that 
there are no other infected files. 

4 Check the repaired files to make sure that they function properly. 
For example, if you repaired a word processing program, start it, edit a 
file, save a file, and so on to make sure that it has been repaired 
correctly.

If Norton AntiVirus can’t repair a file

See “Check product 

version numbers 

and dates” on 

page 62.

If Norton AntiVirus cannot repair the infected file, first make sure you have 
scanned with the latest virus definitions. If you are not sure that you have 
the latest definitions, use LiveUpdate. Then scan your hard disk with the 
latest virus definitions. 
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If removable media is infected

To repair the infected media, use Norton AntiVirus to scan and repair it.

To repair infected removable media

1 Open Norton AntiVirus.

2 In the Norton AntiVirus main window, select the media to scan.

3 Click Scan/Repair.

Look up virus names and definitions

You can look up a virus name from within the Norton AntiVirus 
application. The Virus Definitions Info dialog box lists the viruses in the 
current virus definitions file. To make sure you have the latest virus 
definitions, run LiveUpdate. You can export the list to a text file. You can 
also search the list for a specific virus.

To look up virus names

1 On the Tools menu, click Virus Info.

2 Type the name or part of the name of the virus.
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Look up virus definitions on the Symantec Web site

Because of the large number of viruses, the Virus Definitions Info file does 
not include descriptions of each virus. The Symantec Security Response 
Web site contains a complete list of all known viruses and related malicious 
code, along with descriptions. 

To look up virus definitions

1 Point your browser to the Symantec Security Response Web site at: 
http://securityresponse.symantec.com

2 Click Expanded Threat List and Virus Encyclopedia.

3 Do one of the following:

2 Type a virus name for which to search.

2 Scroll through the alphabetical list to locate a virus.

4 Click a virus to read its description.



Customizing Norton 
AntiVirus
Norton AntiVirus provides the best virus detection and removal with 
default settings left on. If you want to change the default settings because 
you want to extract data from a file before it is deleted or repaired due to a 
virus, you can. 

There are three types of preferences to set. Your options are:

About Auto-Protect Preferences

Active Auto-Protect settings provide you with continuous and ceaseless 
antivirus protection. You can however change automatic antivirus 
protection settings if you want to manually repair or delete a file or if you 
want to manually scan removable media when it is inserted. 

You can change a range of settings for the way Norton AntiVirus Auto-
Protect repairs files.

w For maximum protection leave Auto-Protect on and do not change default 
preferences in the Norton Auto-Protect window.

Scan and Repair Settings that govern the behavior of the Norton AntiVirus 
application and settings separate users can specify

Auto-Protect Settings that govern the behavior of overall antivirus 
protection and repair for your computer

Reminder Settings for the Virus Definition Alert preference
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Set Auto-Protect Preferences

Determine how you want Norton Auto-Protect to monitor viruses and repair 
infected files. 

To set Auto-Protect Preferences

1 In the Norton AntiVirus main window, click Preferences.

2 In the Preferences window, click the Auto-Protect tab.

3 Click Launch Auto-Protect Preferences. 

4 In the Norton Auto-Protect window, click the lock icon to make 
changes. 

5 In the Authenticate dialog box, type your administrator name and 
password.

6 Click OK.

7 Select the Auto-Protect options that you want. Your options are:

8 Close the window to save your changes.

About User Preferences

You can change the preferences that were set up when you installed Norton 
AntiVirus for Macintosh. Moreover, individual users can specify their 
Norton AntiVirus settings.

w For maximum protection do not change default preferences on the Scan, 
Repair, and Reminder tabs.

Auto-Protect Provides automatic virus monitoring.

w If you turn Auto-Protect off all other automatic 
options are unavailable.

Automatic Repair Automatically repairs infected files found.

Quarantine Automatically quarantines files that cannot be 
repaired.

Scan Disks when 
mounted

Automatically scans removable media such as CDs, 
Zip drives, or an iPod when they are inserted in your 
computer.

Scan compressed files Automatically scans compressed files.
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Set Scan Preferences

Determine how you want Norton AntiVirus to scan disks and files.

To set Scan Preferences

1 In the Norton AntiVirus main window, click Preferences.

2 In the Preferences window, on the Scan tab, select the options that you 
want. Your options are:

3 Click Save.

Set Repair Preferences

Determine how you want Norton AntiVirus to repair infected files found 
during a manual scan.

To set Repair Preferences

1 In the Norton AntiVirus main window, click Preferences.

2 In the Preferences window, click the Repair tab.

3 Select the Repair options that you want. Your options are:

4 Click Save.

Scan compressed files Scan compressed files. Scanning time will be longer 
if you scan compressed files.

Scan Results Determine which files you want listed in the Scan 
Results pane of the Scan window.

Scheduled Scan 
Alerts

Specify if you want a scan alert always or only when 
infected files are found. 

Report Format Select the program in which to view saved antivirus 
reports.

Repair During a manual scan, set to repair infected files 
found automatically or manually.

Quarantine files that 
cannot be repaired

During a manual scan, select to automatically 
quarantine files that cannot be repaired.
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Set a Reminder

You can set Norton AntiVirus to notify you when your virus definitions are 
out-of-date. The latest virus definitions are necessary to keep your 
computer virus-free.
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Examining, 
repairing, and 
recovering disks
During its examination process, Norton Disk Doctor runs a series of user-
configurable tests. When repairable problems are found, Norton Disk 
Doctor gives you the option of repairing or ignoring them. Regular 
examination of your disks is the best way to prevent disk damage and data 
loss.

Some startup disk repairs can only be performed when your computer is 
restarted from the CD or another external disk. If you have a damaged or 
crashed disk, start from the CD to run Norton Disk Doctor.

If Norton Disk Doctor cannot repair a disk, use Volume Recover to restore it 
or rebuild its directory. If a disk is unrecoverable, recover files and file 
contents with UnErase.

See “How Norton 

FileSaver protects 

your disks and 

files” on page 50.

Successful repairs to disk and directory information sometimes depend on 
FileSaver data. Be sure to keep FileSaver files up-to-date.

When to use Norton Disk Doctor

See “Set Norton 

Disk Doctor test 

preferences” on 

page 93.

Examine your disks with Norton Disk Doctor regularly, for example, before 
you back up your data files and before you run Norton Speed Disk.

Norton Disk Doctor checks your disk for problems by running a series of 
tests that check the major components of your disk, directories, and files. 
Exclude any tests that you don’t want to run.

See “Run tests with 

Norton Disk Doctor” 

on page 94.

Unless you have specified that it repair problems automatically, Norton 
Disk Doctor requests permission before it performs repairs.
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If problems are found during the examination, Norton Disk Doctor displays 
a Problem Found dialog box. Sometimes Norton Disk Doctor can repair the 
problems immediately. If not, it can create an alias to help you find and fix 
the problem files when the disk examination is complete.

Depending on the type of damage that is found while running the tests, 
Norton Disk Doctor might advise you that your options are to run either 
Volume Recover or UnErase. 

When to use Volume Recover

See “Recover 

damaged disks 

with Volume 

Recover” on 

page 98.

Volume Recover restores data on badly damaged disks. Use Volume 
Recover in the following situations:

1 Your disk is damaged and doesn’t appear on the desktop.

1 Your disk doesn’t appear in the Norton Disk Doctor, UnErase, or 
Volume Recover window.

1 Your disk experiences a problem that Norton Disk Doctor is unable to 
resolve.

1 Your disk has been reinitialized or accidentally erased, or you changed 
your partition structure using driver software.

See “Restore a disk 

using FileSaver 

information” on 

page 104.

Norton Disk Doctor might recommend using Volume Recover if it is unable 
to solve a problem. Volume Recover should be used if you have accidentally 
erased so many files that Norton FileSaver does not track them all 
individually, or if you accidentally deleted a folder that contained many 
files.

When to use UnErase

See “Recover files 

with UnErase” on 

page 107.

If your disk is not damaged, use UnErase to recover files unintentionally 
thrown away. Chances of recovery are better if you use UnErase as soon as 
possible after an accidental deletion. You can also use UnErase to try to 
salvage files from a damaged disk that cannot be repaired by Norton Disk 
Doctor or Volume Recover. 

Chances of recovery are also better if you keep Norton FileSaver files 
current, and if your disk fragmentation level is low. 
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Start Norton Disk Doctor

If you are using Norton Disk Doctor to repair a startup disk, restart from the 
CD before you run Norton Disk Doctor. See “Get information about disks, 
folders, and files” on page 105.

w Make sure you quit all other applications that are running before using 
Norton Disk Doctor to examine a disk. 

See “When disks do 

not show up in a 

list” on page 152.

To open Norton Disk Doctor

1 Open Norton SystemWorks.

2 In the Norton SystemWorks window, click Norton Disk Doctor.

Set Norton Disk Doctor test preferences

Although the default settings are appropriate for most testing, Norton Disk 
Doctor tests can be configured to reflect your work needs or test situations. 
For example, to have Norton Disk Doctor diagnose but not repair a disk, 
specify the options in the Repair Preferences.

The Preferences dialog box displays a list of categories that are represented 
by icons. Each category has detailed subcategories. 

To set Norton Disk Doctor test preferences

1 Open Norton Disk Doctor.

2 On the Norton Disk Doctor menu, click Preferences.

Preference 

categories

Settings change for 

each category
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3 In the list of preference categories, click a category icon. 

4 Continue selecting categories and setting preferences. 

5 Click Save. 
The changes take effect the next time that you examine a disk.

Reset Norton Disk Doctor test preferences

If you have made preference changes, you can reset Norton Disk Doctor 
back to the original default settings.

To reset Norton Disk Doctor test preferences

1 Open Norton Disk Doctor.

2 On the Norton Disk Doctor menu, click Preferences.

3 Click Use Defaults. 

Select the disks to examine

When you open Norton Disk Doctor, the disks that are available for 
examination appear in the list. In the disk column, the name of the disk and 
an icon representing its type appear.

The small icons to the right of the disk icons indicate each disk’s potential 
for examination and repair.

Run tests with Norton Disk Doctor

During the disk examination, Norton Disk Doctor checks every area of your 
disk, looking for problems that need immediate attention as well as 
conditions that could create future problems. A hard disk examination 
might take time, but Norton Disk Doctor keeps you informed and provides 
suggestions to help you decide how to handle problems.

If you are unsure about a repair decision, skip it. After the examination, 
print the Norton Disk Doctor Report and refer to it when you examine the 
disk again. 

Macintosh icon  The disk contains the active System file of your 
Macintosh. 

Application icon  The disk contains the Norton Disk Doctor application.

Lock icon   The disk is write-protected and Norton Disk Doctor 
can examine the disk, but cannot perform any repairs 
on it. 
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Examine disks

See “Examine your 

startup disk” on 

page 34.

If major problems are found on your startup disk, restart your computer 
from the CD and run Norton Disk Doctor to repair the problems.

To examine a disk

1 In the Norton Disk Doctor main window, select one or more disks. 
If the disk is a floppy disk or other type of removable media, insert it 
now. 

2 Click Examine.

This window shows the progress of Norton Disk Doctor as it runs its 
series of tests on each disk.

3 You can select any of the following during an examination. Your 
options are:

If your disk is damaged severely and you choose not to fix problems, 
Norton Disk Doctor might be unable to finish diagnosing the disk. 
Norton Disk Doctor informs you when it cannot continue.

Skip Skip a test.

Skip Disk Skip the remaining tests for this disk. If another disk is 
selected, Norton Disk Doctor proceeds to examine it.

Stop Stop examining all disks.
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When Norton Disk Doctor is finished, it displays the results for each disk 
tested in a report window.

w An error found might be caused by the disk directory changing during the 
examination process. To determine whether a reported problem is a false 
error, you can run Norton Disk Doctor again from your hard drive to see 
whether the error appears again. If it does not appear again, then you can 
safely ignore it.

If Norton Disk Doctor finds a problem

When Norton Disk Doctor encounters a problem, it displays an alert. 

The Problem dialog box describes the type of error and the files or other 
disk elements that are affected:

1 If the problem can be fixed, Norton Disk Doctor displays the 
recommended action and lets you decide whether to fix it.

1 If Norton Disk Doctor cannot fix the problem, it makes a 
recommendation. See “About Norton Disk Doctor messages” on 
page 135.

1 If Norton Disk Doctor detects damage it cannot repair, Volume Recover 
may be recommended. See “Recover damaged disks with Volume 
Recover” on page 98.

Location and 

description of 

problem

Recommended 

action

Available actions
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To respond to alerts

4 Select one of the following:

2 Fix
Repair the problem in the selected file and continue with the rest 
of the tests.

2 Fix All
Repair the problem in all of the listed files.

2 Continue
Skip the repair and continue examining the disk.

2 Stop
Stop the disk examination.

You might need to restart your computer before the repairs take effect. 

If a disk was not originally mounted on the Desktop, Norton Disk Doctor 
will attempt to remount the disk when the examination is finished.

If Norton Disk Doctor can’t complete the examination

“When to use 

Volume Recover” 

on page 92

If an unexpected problem occurs and Norton Disk Doctor is unable to 
complete the examination, try running the examination again. If that fails, 
try to solve the problem using Volume Recover.

If Norton Disk Doctor can’t repair a problem

See “Recover files 

with UnErase” on 

page 107.

Occasionally, a disk or file is so severely damaged that no software 
program can fix it. If a disk is badly damaged, Norton Disk Doctor displays 
a dialog box that tells you to back up and reformat the disk. If a file is badly 
damaged, try to recover its contents with UnErase.

For more information, see the online Help.
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Recover damaged disks with Volume Recover

The Volume Recover feature restores your disk in one of two ways:

What Volume Recover can’t do

Volume Recover cannot recover a hard disk that has been low-level 
formatted, as this type of initialization completely erases all information on 
the disk.

See “What tool 

should you use for 

your problem?” on 

page 16.

Volume Recover does not recover data to your Startup Disk. On a locked 
disk, you can create a Virtual Disk, but you cannot save the Virtual Disk or 
change the original disk’s directory.

Identify the preferred recovery method

Both the Create and View Virtual Disk and FileSaver Search features 
provide efficient ways to recover your data. To help you choose a method, 
use the following table.

Function For more information

Using the Create and View Virtual Disk function, 
Volume Recover will create a Virtual Disk - an advance 
look of the rebuilt disk that you can compare with the 
original damaged disk. From this Virtual Disk, you can 
copy files and documents to another volume for 
backup purposes, or you can choose to rebuild the 
original disk to the state of the Virtual Disk. 

See “Use the Create and 

View Virtual Disk function” 

on page 100.

Using the FileSaver Search, existing FileSaver files 
can be used to recreate a damaged disk to the state 
that it was in when Norton FileSaver recorded the 
information. FileSaver files contain critical 
information that identifies the structure of a disk. By 
restoring this information, you might be able to return 
the disk to a condition that Norton Disk Doctor can 
repair. 

See “How Norton FileSaver 

protects your disks and 

files” on page 50.

Condition Recommended action

You have just purchased this product because you 
have lost or damaged files.

Create and View Virtual 
Disk

The FileSaver information is older than the files you 
wish to recover. 

Create and View Virtual 
Disk
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When FileSaver information is out-of-date, restoring old FileSaver data can 
make future data recovery efforts difficult. An exception to this is a case in 
which you have not used your computer for an extended period of time, 
meaning that you haven’t updated or changed your files simply because 
your computer has not been used. In this situation, FileSaver data might 
prove useful.

Select the disk to recover

See “When disks do 

not show up in a 

list” on page 152.

Volume Recover scans for disks. The available disks appear in the Volume 
Recover main window.

To open Volume Recover

1 In the Norton Launcher, click Volume Recover.

2 In the Volume Recover main window, select the volume or disk whose 
information you want to recover.

You know that Norton FileSaver was not active for the 
damaged disk or the information on the disk is 
damaged. 

Create and View Virtual 
Disk

You are not sure which search to perform. Create and View Virtual 
Disk

FileSaver is running and it captured a snapshot of 
your data before it was lost or damaged. 

FileSaver Search 

Condition Recommended action
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If you don’t see the disk that you’re looking for

Your disk’s name may appear different, or be unrecognizable, due to 
damage to the disk’s structures. You may be able to recognize it from 
information such as the size or location of the disk provided in the Get Info 
dialog box.

Use the Create and View Virtual Disk function

If missing files are not listed in a disk’s directory because damage to the 
directory prevents the corresponding directory entries from being found, 
you can use the Create and View Virtual Disk function.

You can use the Create and View Virtual Disk function to rebuild damaged 
or missing directory data even if there is no FileSaver data for the disk. Get 
Info also lets you change the names of files and folders. 

Volume Recover scavenges the damaged disk for directory information and 
rebuilds the structure according to the file records and other information 
found.

Using Create and View Virtual Disk allows you to scan the hard disk for all 
file records and creates a Virtual Disk of the rebuilt disk that contains those 
records. After you have examined the Virtual Disk, you can choose to have 
Volume Recover permanently write the rebuilt directory to your disk. If you 
prefer, you can backup data onto another disk, such as an external drive, 
without altering the original disk. If your disk is badly damaged, the Create 
and View Virtual Disk function might need to search the entire disk to 
ensure that all data exists.

w The recovery of any additional files found by this search might result in the 
loss of other valid files, if the additional files have the same names as the 
more recent files. This is particularly true when the directories on the disk 
are fragmented. If the disk was recently optimized with Speed Disk, there is 
little risk of file loss.

If you are running Mac Classic

In order to open Classic applications while in Explore Mode, you will need 
to set the Classic preference. When this preference is set, the Explore Mode 
screen background will not appear, but you will still be in Explore Mode.
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To set the Classic preference

1 On the Volume Recover menu, click Preferences.

2 Click the box to run programs in Mac Classic during Explore Mode.

3 Click OK.

Create the Virtual Disk

Starting the Create and View Virtual Disk function is the first step to 
rebuilding your disk.

To create the virtual disk

1 In the Volume Recover main window, select the disk to recover.

2 Click Create & View Virtual Disk.
After files are located, your computer screen will appear in Explore 
Mode and display your original disk and the Virtual Disk.
Explore Mode means that you are viewing an advance look of the 
rebuilt disk (the Virtual Disk) and have not yet decided to rebuild your 
directory. 
In Explore Mode, both the Virtual Disk and the original disk are read-
only and your screen background will have a different pattern to it. No 
edits or changes can be performed on files from these two disks at this 
time.

w You can now compare the original disk and the Virtual Disk in Explore 
Mode unless the original disk is so badly damaged that it cannot be 
mounted.

3 If there are any files on the Virtual Disk that you wish to back up 
immediately, drag the icon of the desired file from the Virtual Disk 
onto another disk, such as an external drive. These files will now be 
backed up on the disk to which you have copied them.

4 If the Rebuild Options screen does not display automatically, click 
Continue.

w Rebuilding your disk is permanent. If you did not find the files that you 
were looking for, or if you have fewer files on your Virtual Disk than 
on your original disk, do not rebuild your disk at this time. Instead, 
click Search More to continue searching for files. 
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5 In the Rebuild Options window, select the action that you want to take. 
Your options are:

Find deleted files using the Create and View Virtual Disk function

Create and View Virtual Disk also lets you search for deleted files. 
However, only a small percentage of deleted files are located using this 
method. This option may also result in unwanted files and documents being 
restored. 

To set the Deleted Files preference

1 Be sure that you have exited Explore Mode.

2 On the Volume Recover menu, select Preferences.

3 Check the box to look for deleted files. 

4 Click OK. 

5 Click Create and View Virtual Disk.

Prepare the rebuilt disk for use

The rebuilt disk replaces the original disk immediately. 

Rebuild Disk If the Virtual Disk is acceptable, choose this option to 
rebuild your original disk to the state of the Virtual 
Disk.

Search More If the Virtual Disk is incomplete, choose this option to 
search for more files. This process may take a long 
time. A message will display asking if you wish to 
search the entire device. To continue searching, click 
Proceed. 

Quit & Don’t Save To return to the main Volume Recover window, 
choose this option. The Virtual Disk is unmounted 
and will not be saved. At this point, you will exit 
Explore Mode.

If you have backed up files from the Virtual Disk onto 
another drive (other than the original disk), your files 
will be available to you on the disk to which you 
copied. However, you will still need to rebuild or 
initialize your original disk at some time in the 
future. 

If you have not backed up any files that appear on the 
Virtual Disk, those files will not be recovered or 
saved when you choose this option. 
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To prepare the recovered disk for use

1 As a precaution, copy any critical files from your computer’s rebuilt 
disk to another disk.

See “Examine 

disks” on page 95.

2 Run Norton Disk Doctor to examine and further repair the disk with 
the newly restored directory information. 

Perform a FileSaver Search

Before proceeding with FileSaver Search, be aware of the following:

1 Any files that were created after the most recent FileSaver information 
file are not recovered. 

1 Any file that was modified or deleted after the FileSaver information 
files were last saved is recovered but might be damaged.

1 You cannot undo the Volume Recover process.

w If you do not have FileSaver turned on, or if Norton SystemWorks was not 
installed when your disk became damaged, do not use this feature. Instead, 
use the Create and View Virtual Disk function.

When you have located the disk that you want to recover, search for 
FileSaver information.

To search for FileSaver information

1 In the Volume Recover main window, select the disk to recover.

2 Click FileSaver Search. 
Volume Recover searches your drive for information stored by 
FileSaver to recover your disk. 
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If an expected FileSaver file isn’t found

If the located FileSaver information is not for the volume that you want to 
recover, or if you think there is more recent FileSaver information for the 
volume, Volume Recover can search for more FileSaver files.

To search for more files

1 In the Volume Recover search results window, click Search More.
If FileSaver information is still not found, Volume Recover scans the 
partition.

2 To scan the entire physical device, click Search More again.

See “Use the Create 

and View Virtual 

Disk function” on 

page 100.

If Volume Recover still can’t find FileSaver information, or the FileSaver 
information is more than one week old, try using the Create and View 
Virtual Disk function. 

See “How Norton 

FileSaver protects 

your disks and 

files” on page 50.

If no suitable FileSaver files are found, be sure that for the future Norton 
FileSaver is configured to protect your files and volumes.

Restore a disk using FileSaver information

After starting Volume Recover and locating a FileSaver file using FileSaver 
Search, complete the restoration of your disk. Always select the most 
recent FileSaver file, unless you know that your disk was damaged before 
the date and time that the file was saved.
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To restore a disk using FileSaver information

1 Select a FileSaver file.

2 Click Restore.
Volume Recover informs you that the disk’s directory information will 
be replaced by the FileSaver information.

3 Click Proceed to recover the FileSaver information to the selected 
volume.

Prepare the recovered disk for use

If recovery with the FileSaver file is successful, you must restart your 
computer to complete the recovery.

To prepare the recovered disk for use

1 Restart your computer. 
After you restart, the restored FileSaver information takes the place of 
the current disk information.

2 As a precaution, copy any critical files from your computer’s restored 
disk to another disk.

See “Examine 

disks” on page 95.

3 Run Norton Disk Doctor to examine and further repair the disk with 
the newly restored directory and partition information. 

If recovery is not successful

See “Recover files 

with UnErase” on 

page 107.

If Volume Recover is unable to restore your disk, try the UnErase feature to 
recover files.

Get information about disks, folders, and files

The Get Info feature lets you view information about disks, folders, and 
files. If a disk or file doesn’t have an icon or name, use Get Info to identify 
it. In a Get Info window, you can change the Finder flag, File type and 
Creator codes, and the name of a selected item.
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View file, folder, and disk information

The Get Info feature lets you view and change Finder flags, File type and 
creator information for disks, applications, files, and folders. Changes that 
are made in the Get Info windows are permanent and will remain until you 
or the System changes them.

w Editing Finder flags, Creator, and Type characteristics requires technical 
expertise. Do not change them unless it is absolutely necessary.

To view information for a disk, file, or folder

1 Open Norton Disk Doctor, Volume Recover, or Norton Disk Editor X.

2 Do one of the following:

2 On the File menu, click Get Info For and select the disk for 
which you want information. 

2 Click Get Info.

3 Change the desired options, if needed.

4 Click the close box.

See “Access Help” 

on page 53.

For more information about Get Info windows, see the online Help.



Recovering missing 
or erased files
If you have accidentally deleted files, if files are missing, or if Norton Disk 
Doctor reports that a disk is irreparably damaged, use UnErase to recover 
the files or data and move them to a safe location. 

Recover files with UnErase

UnErase provides powerful search and data-recovery capabilities. The basic 
Quick Search operation is simple, almost completely automatic, and uses 
the method most likely to succeed.

UnErase search methods

Unerase uses the following process:

1 Unerase tries a Quick Search first. This uses File Saver information, if 
available and combines this search with a Catalog Search for erased 
files.

1 If no FileSaver information is found, the Quick Search returns the 
results of a Catalog Search for erased files only.

1 If this first Quick Search is unsuccessful, start a Customized Search 
and select File Pattern Search or Text Search.

1 If you are looking for files that are missing due to directory damage, 
rather than files that have been thrown away, start a Customized 
Search and select Catalog Search, looking for both real and erased 
files.
See “Perform Catalog, File Type, and Text searches” on page 113.
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Before using UnErase

See “When to use 

Norton Disk Doctor” 

on page 91.

If files or folders have unexpectedly disappeared, there might be a problem 
with your directory. Run Norton Disk Doctor before searching with 
UnErase. Norton Disk Doctor might be able to repair a damaged directory. 
Before using UnErase, double-check the Trash for the missing files or 
folders.

Open UnErase

When you open UnErase, disks appear in the UnErase list.

There are contextual menu and drag and drop shortcuts that you can use 
with UnErase.

To open UnErase

4 In the Norton SystemWorks main window, click UnErase.

Use Quick Search

See “Sort or filter 

UnErase search 

results” on 

page 110.

After you have started UnErase, select the disk on which the missing file 
was located and perform a Quick Search.
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To perform a Quick Search

1 In the UnErase window, select the disk that contains the erased file.

2 Click Quick Search.
UnErase searches the selected disk for erased files and displays the 
results in the UnErase Search window.

If the file isn’t found by Quick Search

If a missing file doesn’t appear after a Quick Search, it might be on a 
different disk or need a more customized search.

Use the following options to continue searching:

1 If the file might be on another disk, select that disk and perform 
another Quick Search.

1 If you know that the missing file was on the disk that you searched, try 
a Customized Search. See “Perform Catalog, File Type, and Text 
searches” on page 113.

Manage UnErase search results

After performing a Quick Search, UnErase displays the results in the 
UnErase Search results window, along with an estimate of the file’s 
recoverability. 

If it is obtainable, the selected file’s last location appears in the bottom 
pane of the UnErase Search window.

Estimate of file’s 

recoverability

Click a column 

title to sort the 

list

Select one or 

more files or 

folders

Select a customized

search

Get information 

View contents 

of selected file
Size of selected 

item

Location of file 

before it was 

erased
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Sort or filter UnErase search results

When UnErase searches for erased files, it might display many files and 
folders that you don’t want to see. You can sort the files in ascending or 
descending order by column. You can also apply a filter to hide unwanted 
files and folders in the display. If the recoverability estimate is low, you can 
select a filter to limit the time that UnErase spends searching for the file. 
You can also examine a file’s contents to determine if it is worth 
recovering. 

To sort the found files

4 In the UnErase Search results window, click any column title.
The highlighted column title indicates the current sort order.

Use a filter to hide unwanted file and folder types in the UnErase Search 
results list.

To filter the list of found files

1 In the UnErase Search window, click Filter List.
This option is available when Hide Unrecoverable Files is unchecked.

Type partial 

text to 

search for a 

file name

Select file 

types

Type text that is 

in the file for 

which to search

Specify the 

size of the 

file for 

which to 

search

Check the filters 

that you want to 

use

Apply the filter to 

the UnErase Search 

results window

Create a File Type 

template

Include or exclude 

filter criteria
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2 In the Filter List dialog box, check the filters that you want to use.

3 Click Apply Filter.

When you no longer need a filter, remove it from the UnErase search.

To remove a filter

4 In the UnErase Search window, click Remove Filter.

To change an active filter

1 In the UnErase Search window, click Filter List.

2 Make changes to the filter criteria.

3 Click Apply Filter.

View a file’s information or contents

In the UnErase Search results window, you can view more information 
about a file, or its contents. 

For more information, see the online Help.

Recover a file or folder

When you have identified a file to recover, select a destination for the 
recovered file. Although you can recover an erased file to the same disk, it 
is safer to specify a Zip disk or other removable media, a network disk, or 
another hard disk if you have one. When you recover to the same disk, you 
jeopardize your chances of recovering other erased files. 

To recover a file or folder

1 In the UnErase Search results list, select one or more items.

2 Click Recover.

3 Select a disk on which to save the recovered files. 
If the destination disk doesn’t have enough space, UnErase splits the 
file.

4 Click Recover.
UnErase recovers the files and displays a status message.

When UnErase recovers a file using a Quick Search or Catalog Search, it 
creates a folder with the same hierarchy and name as the last folder in 
which the file resided. This folder is placed within a folder called Recovered 
Files.
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If you have previously dragged a file to the Trash and then emptied the 
Trash, UnErase attempts to determine the folder from which the file was 
originally taken. However, if necessary, UnErase creates a .Trashes folder 
inside of the Recovered Files folder. Do not confuse this folder with the 
original Trash.

Restore recovered files

Some files need additional treatment before they are fully restored. You 
might need to join a file’s data and resource forks on some file types or 
rejoin segments of a large file that was split into segments during recovery.

w Recovered files will have your permissions rather than the file’s original 
permissions. These permissions allow you to examine the file. You may 
want to change the permissions after recovery. 

Join data and resource forks

When you recover an erased file that has a resource fork and a data fork, 
you might have to rejoin the two parts to restore the file to its original 
condition. In a File Type search, UnErase lists each fork as a separate file.

For more information, see the online Help.

To restore the order in which files were found

4 In the search results list, press Option and click any column heading. 
This removes any sorting from the list.

Once you have located matching data and resource forks, you can join 
them.

To join previously recovered resource and data forks

1 Open UnErase.

2 On the Tools menu, click Join Forks.

3 In the Join Forks dialog box, click the first Select File button.

4 Locate the Recovered Files folder, then select the data fork.

5 Click Open.
The file name appears next to the first Select File button.
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6 Click the second Select File button.

7 Locate the Recovered Files folder, then select the resource fork.

8 Click Open.
The file name appears next to the second Select File button.

9 Click the third Select File button.

10 Select a location, then type a name for the joined file.

11 Click Save.

12 Click Join.
UnErase displays the status of the joined file.
You should now be able to open the file using the program that created 
it.

If you are unable to join forks

If you are not successful in joining resource and data forks, save the data 
from the data fork by copying it to another file.

Perform customized searches

A customized search might find erased files that are not found through a 
Quick Search. Available options in customized searches include Catalog, 
File Type, and Text searches. 

If the first customized search method is unsuccessful, try another, or 
combine them.

Perform Catalog, File Type, and Text searches

If using the Catalog Search function is unsuccessful but you know which 
program was used to create a lost file, try a File Type Search, or use a Text 
Search to search for specific text within a file.
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To perform a customized search

1 Do one of the following:

2 In the Search Results window, click Customized Search.

2 On the Tools menu, click Customized Search.

2 Select the disk on which to search.

3 Check the types of files to include. Your options are:

4 Under Criteria, check the search options for this search. 

5 On the search tabs, specify the details for your customized search.

6 Click Search.

For more information, see the online Help.

Check customized 

search criteria

Specify 

options for 

selected 

search 

criteria

Check one 

or both

Erased files UnErase searches for files in the unused and erased 
files area of your disk. If your disk is healthy, this is 
the best choice.

Real files UnErase searches currently used areas of your hard 
disk. If your disk directory information has been 
damaged, check both real files and erased files for 
best results.



Enhancing 
performance and 
security
Norton SystemWorks includes productivity-enhancing features that 
improve performance, test your computer’s performance against 
standardized benchmarks, and assist with security and confidentiality.

Improve a computer’s performance

Speed Disk is a powerful optimization utility that defragments files and 
free space and organizes files on the disk to provide faster performance. It 
lets you customize file arrangement to match your computing activity. 

Performing a complete optimization of your disk is the only way to provide 
defragmentation of the directory, improving both the performance and 
security of your disk.

For more information see the online Help.

About optimization and file fragmentation

The terms defragmentation and optimization are often used 
interchangeably, but they are not the same. 

1 Defragmentation is the process of arranging the way that files are 
organized on a disk so that the data that comprises each file is stored 
in adjacent blocks. 

1 Optimization is the process of arranging the way that files are 
organized on a disk so that frequently used files and file types can be 
accessed easily.
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How Speed Disk optimizes

Speed Disk optimizes your disk by placing files on the disk according to file 
type. For example, system files are placed together where they can be 
accessed efficiently. Desktop files, documents, and other frequently used 
files are placed adjacent to free space where they have room to grow with 
minimal fragmentation. 

For more information see the online Help.

Open Speed Disk

If you want to optimize your startup disk, you must start from the CD or 
another disk.

To open Speed Disk

1 In the Norton SystemWorks main window, click Speed Disk.

2 In the dialog box that appears, read the cautionary message.

3 To prevent the dialog box from appearing again, check Don’t show 
this alert again.

w If you have booted from the CD, it is not possible to prevent the dialog 
box from appearing.

4 Click OK.
When you open Speed Disk, the available disks appear in the window. 
On the selected disk’s map, used areas appear in black and free areas 
in white.

Optimize a disk

When you have identified the disk that you want to optimize, you can 
proceed. To optimize your startup disk, you must be restarted from the CD.

To optimize a disk

1 In the Speed Disk window, select a disk.

2 To analyze the disk before performing the optimization, click Check 
Disk.
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3 Click Optimize.
Speed Disk starts optimizing the selected disk.

4 If bad blocks are found, run Norton Disk Doctor Media Check to correct 
them or mark them to prevent further use. 
Marking bad blocks does not eliminate them from the disk. To ensure 
future data integrity, back up disks containing bad blocks and 
reformat them using the disk’s formatting software.

When optimization is complete, Speed Disk has defragmented files and 
arranged file types for optimal use.

If you want to optimize a startup disk

See “Start from the 

CD” on page 17.

To optimize your startup disk, restart your computer from another disk or 
from the CD.

Defragment files

The optimization process can’t work with files that are open or in use, 
locked disks, or unmountable partitions. Your startup disk always has open 
files, so you must start from the CD or another designated disk to optimize 
your startup disk. You can still defragment files on disks that have files in 
use.

To view and defragment selected files

1 In the Speed Disk window, select a disk.

2 On the Explore menu, click Show Fragmented Files.
The Fragmented Files dialog box lists all of the fragmented files, their 
sizes, and the number of fragments.
Some files can’t be defragmented. The reasons for their unavailability 
are listed in the Note column.

3 To sort the list, click any of the column headings. To reverse the order 
of the sort, click the triangular icon to the right of the Note column 
heading.

4 In the Fragmented File dialog box, do one of the following:

2 Select one or more files to defragment.

2 To select all files, press Command-A.

5 Click Defragment Selected Files.
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Schedule defragmentation of files

Use the Norton Scheduler to schedule your computer for file 
defragmentation during times that are most convenient for you.

It is recommended that you completely optimize your disk with Speed Disk 
before performing the defragmentation process. Otherwise, 
defragmentation will take longer to complete.

See “Using the 

FileSaver window” 

on page 50.

Scheduled defragmentation can take place only when the disk is checked 
in the FileSaver window. However, you can defragment files with Speed 
Disk at any time, regardless of settings in the FileSaver window.

Set Speed Disk preferences

You can customize the optimization process. You can specify the degree of 
file and data verification that you want Speed Disk to use during 
optimization, and how you want Speed Disk to notify you when it is 
finished optimizing. Speed Disk can launch Wipe Info to remove residual 
data from free space.

To set Speed Disk preferences

1 Open Speed Disk.

2 On the Options menu, check the options that you want Speed Disk to 
perform during optimization. 

3 Repeat the process to choose another option.
Your selections take effect immediately.

Customize optimization

See “Set Speed Disk 

preferences” on 

page 118.

Speed Disk comes with predefined profiles that define how file types are 
arranged on a disk during optimization. For example, if you work with a lot 
of multimedia files, you can select the Multimedia profile, and Speed Disk 
optimizes your disk according to the typical activities of multimedia file 
users. If no built-in profile meets your needs, you can design your own with 
the Speed Disk Profile Editor. 

For more information see the online Help.
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Select a Speed Disk profile

Speed Disk normally runs with the General Use profile. This setting usually 
provides the best performance, and doesn’t need to be changed unless your 
files require special consideration. Other built-in profiles are designed for 
CD mastering, heavy multimedia use, and consolidating free space.

To select a Speed Disk profile

1 Open Speed Disk.

2 On the Options menu, select a profile from the Optimize For submenu.

To search for other Speed Disk Profile Editor documents

1 Open Speed Disk.

2 On the Options menu, on the Optimize For submenu, click Add 
Profiles.

3 Search for and select a folder that contains Speed Disk Profile Editor 
documents.

4 Click Choose.

Remove data permanently

Wipe Info is used to delete data that you do not want anyone to ever see. It 
will permanently remove any evidence of the data from your computer. 

When to use Wipe Info

You can use Wipe Info to permanently delete information, to clean unused 
disk space, and to ensure that no sensitive information that was inside of 
invisible, temporary files still exists in unallocated fragments.

How Wipe Info works

When you empty the Trash or erase a disk, only the bookkeeping 
information about the disk is modified. The data in erased files remains on 
the disk, even though the file names no longer appear in any folder, until 
the space is needed to store other files. This poses a security risk for 
sensitive and confidential documents. 

w Wipe Info permanently removes the file data along with the entire 
allocation block where the data is stored. 
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Open Wipe Info

Open Wipe Info when you have restarted from the CD.

The Wipe Info main window contains three disk wiping operations: Wipe 
File/Folder, Wipe Disk, and Wipe Unused Space. A fourth option, Wipe 
Entire Device, is available from the Wipe menu. There are contextual 
menus and drag-and-drop shortcuts that you can use with Wipe Info. 

To open Wipe Info

1 Open Norton SystemWorks.

2 On the Norton Launcher, click Wipe Info.

Wipe items on your disks

Wipe Info can eradicate a single file or a folder that is filled with files. 

To wipe a file or folder

1 In the Wipe Info main window, click Wipe File/Folder.

2 Select a file or folder to delete.

3 Click Wipe.
You are asked to confirm the deletion.

4 Click Wipe.
Wipe Info erases the selected file or folder permanently.



Enhancing performance and security

Wipe items on your disks
121
To wipe an entire disk

1 In the Wipe Info main window, click Wipe Disk.

2 In the drive selection dialog box, select a disk drive.

3 Click Wipe Disk.

4 When prompted, type a new name for the disk.

5 Click Wipe.
Wipe Info erases the entire selected disk permanently. 

You can wipe any USB, SCSI, FireWire, or IDE device, such as a Zip drive, 
as well as internal or external hard disks. If the device is large, the wiping 
process might require a significant amount of time to complete.

To wipe a device

1 Open Wipe Info.

2 On the Wipe menu, click Wipe Entire Device.
The Select Device window lists available devices.

3 If the device that you want to wipe does not appear, recheck all cables 
and power to the device, and click Rescan.

4 Select a device in the list.

5 Click Wipe Entire Device.

6 When prompted, click Wipe.
Wipe Info erases the selected device.

w After erasing the device, you will need to reformat it with a compatible 
formatting software program such as the Apple Disk Utility, FWB Hard 
Disk Toolkit or a similar disk tool that is designed to work with the device 
make and model.

All known devices 

on the bus Mounted disks

Look for other 

devices
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To wipe unused disk space

1 In the Wipe Info main window, click Wipe Unused Space. 

2 Select the device whose unused space you want to delete. 

3 In the Selection dialog box, click Wipe Unused Space.

4 When prompted, click Wipe.
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Norton SystemWorks 
featured products
The Norton SystemWorks CD includes the following products from other 
manufacturers:

1 Dantz Retrospect Express: Lets you create backups of your disks and 
files quickly and easily. Retrospect Express works with a wide range of 
removable media, including Zip disks, Jaz drives, CD-R/RWs, DVD-R/
RWs, and hard drives.

1 Aladdin Spring Cleaning: Mac OS 8.1 to 9.x and Mac OS X versions of a 
utility that removes unwanted files from your hard drive.

Retrospect Express quick start documentation

The CD includes the Retrospect Express User’s Guide and Retrospect Express 
Tutorials Quick Start PDFs in the Retrospect Express 5.0 folder. These PDFs 
were written for Retrospect Express version 4.3, and do not fully document 
the features of Retrospect Express 5.0 for Mac OS X.

See “Access the 

Retrospect Express 

PDFs and Read Me” 

on page 128.

The Retrospect Express Read Me file includes information that was not 
available when the Retrospect Express User’s Guide PDF was finalized. It 
includes late-breaking information, issues with specific types of hardware 
and backup media, and platform-specific advice.

w The Dantz Web site is constantly updated with the most recent support 
information for Retrospect Express. Point your browser to the following 
Web page:
http://www.dantz.com
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What’s new in Retrospect Express

This version of Retrospect Express has the following features:

1 Support for Mac OS 9 and Mac OS X

1 Support for UNIX ownership and permissions

1 Ability to restore volumes in Mac OS X

1 Backup capability for files that are larger than 2 GB

1 Support for file backup sets that exceed 70,000 files

1 Support for large file backup sets that are not constrained by Mac OS 
resource fork size limitations

1 Support for automated scripts that can launch Retrospect Express with 
no dependency on a user login ID

1 Support for DVD-R, DVD-RW, and Apple SuperDrive as backup media 
devices

1 Live Restore for Mac OS X

Retrospect Express system requirements

Retrospect Express requires the following backup computer hardware and 
software:

1 PowerPC-based Macintosh computer (G3 or later in Mac OS X)

1 Mac OS 9.0 or later, or Mac OS X version 10.1.2 or later

1 For Mac OS 9: Minimum 64 MB of RAM (128 MB recommended)

1 For Mac OS X: Minimum 128 MB of RAM (256 MB recommended)

1 Hard disk drive with a minimum of 50 MB free space

Install Retrospect Express

See “To check your 

login type” on 

page 36.

In Mac OS X, the Retrospect Express installer requires an administrator 
login and password for authentication.

To install Retrospect Express

1 Insert the CD into your CD-ROM drive.

2 Open the Retrospect Express 5.0 folder.

3 Double-click Install Retrospect Express.

4 In the Authenticate dialog box, type an administrator password.
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5 Click Continue.

6 In the Licence Agreement window, click Agree.
If you click Disagree, the installer quits.

7 Click Install.
You can change from Easy Install to Custom Install to select the 
Retrospect Express documentation as well as the application.

8 Follow the on-screen instructions to complete the installation.

The program files are installed in the Applications folder, in a folder named 
Retrospect Express 5.0.

Remove Retrospect Express

If you need to remove Retrospect Express from your computer, delete files 
from their installed locations.

To remove Retrospect Express

4 Drag the following items to the Trash:

2 /Applications/Retrospect Express 5.0/ (Mac OS 9 and X)

2 /Library/Preferences/Retrospect/ (Mac OS X)

2 /Library/StartupItems/RetroRunHelper/ (Mac OS X)

2 /System/Preferences/Retrospect/ (Mac OS 9)

In Mac OS X, you must restart your computer before you can empty the 
Trash.

Start Retrospect Express

See “To check your 

login type” on 

page 44.

The first time that you open Retrospect Express in Mac OS X, you need to 
enter an administrator login ID and password. 

To start Retrospect Express in Mac OS X

1 In the Applications folder, double-click the Retrospect Express 5.0 
folder.

2 Double-click Retrospect.
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3 In the Retrospect Backup registration dialog box, select one of the 
following:

2 Already Registered

2 Register Later

2 Register Now

4 At the prompt, type an administrator password. 

See the Retrospect 

Express User’s 

Guide on the CD.

To avoid this prompt, uncheck Always require authentication. 
You can also specify your security login preference in the Retrospect 
Express Preferences.

Access the Retrospect Express PDFs and Read Me

The Retrospect Express User’s Guide contains detailed information on how to 
use Retrospect Express version 5.0. The Retrospect Express Read Me file 
contains late-breaking information that was not available when the 
Retrospect Express User’s Guide PDF was produced. Check the Dantz Web 
site for updates to this documentation. 

If you don’t have Adobe Acrobat Reader installed, you can install it from the 
CD.

To open the Retrospect Express PDFs

1 Insert the CD into the CD-ROM drive.

2 Double-click the Install Retrospect Express folder.

3 Select one of the following:

2 Retrospect Express Quick Start: This PDF includes instructions 
for installing and using Retrospect Express in Windows and 
Macintosh operating systems.

2 Retrospect Express User’s Guide: This PDF includes detailed 
instructions for using Retrospect Express.

2 Retrospect Express Read Me: This opens the Retrospect 
Express.html file.

About backup devices

See “Contacting 

Dantz Development 

Corporation” on 

page 168.

The Dantz Web site has a list of backup devices that are supported by 
Retrospect Express. If your drive is not listed, it might not be supported. If 
you have questions about support for your drive, contact Dantz Technical 
Support.
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Determine your drive’s firmware

Certain drives require specific versions of firmware, the drive’s built-in 
controlling software. 

To determine your drive’s firmware version

1 On the Retrospect Express Configure tab, click Devices.

2 Click Device Status and look under the Version column.
If your firmware is an earlier version than is required, contact your 
drive vendor.

Optical or cartridge drive issues

Retrospect Express supports all drives that appear as volumes on the 
Desktop. This includes removable cartridge drives from Iomega, Imation’s 
SuperDisk, DVD-RAM drives from Hitachi, Panasonic, and Toshiba, and 
magneto-optical drives from Epson, Fujitsu, Mitsubishi Chemical, 
Olympus, Philips, Pinnacle, Ricoh, Sony, and others.

The Retrospect Express storage devices window shows removable disk 
drives with mounted media. When it shows a local hard disk, the formatter 
that was used to format the hard disk informed the Mac OS that the fixed 
hard disk is removable or ejectable. Contact the formatter’s vendor to find 
out how to configure your hard disk so that it does not appear ejectable to 
the Mac OS.

w If your formatting software makes a hard disk appear ejectable and you are 
backing up to removable disks, be careful not to accidentally select the 
hard disk as a backup destination.

FireWire/IDE/USB removable drive issues

For best results with a non-SCSI removable cartridge drive such as 
FireWire, IDE, or USB, before using it with Retrospect Express, use the 
drive’s latest software to format the cartridge. This ensures that your 
Macintosh can mount cartridges from the drive after a disaster when your 
normal startup drive is down and you have to start your Macintosh from the 
CD to recover.
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Unsupported devices

The following drives may include Retrospect Express software at the time 
of purchase, but they do not operate under Mac OS X and cannot be used 
with Retrospect Express 5.0:

1 Seagate USB Travan TR4 (USB 1.1)

1 Seagate USB Travan TR5 (USB 1.1)

1 OnStream USB-30

Spring Cleaning quick start

Aladdin Spring Cleaning is an uninstaller program that helps you recover 
disk space by letting you remove and manage your files and programs. For 
more comprehensive documentation, see the Spring Cleaning User's Guide 
PDF in the Spring Cleaning folder on the CD.

Spring Cleaning system requirements

Spring Cleaning has the following system requirements:

1 Power Macintosh computer

1 Mac OS 8.6 or later, with CarbonLib 1.5 or later

1 Mac OS 8.1 requires Navigation 1.0.1 or later

1 4 MB free RAM

1 13 MB of disk space

Install Spring Cleaning

You can install the Spring Cleaning program from the CD by first copying 
the Spring Cleaning installer icon to your computer’s hard disk.

To install Spring Cleaning in Mac OS X

1 Copy the Spring Cleaning installer icon from the CD to your computer. 

2 Double-click the Spring Cleaning installer on your disk and continue 
from step 3 of “To install Spring Cleaning.”

To install Spring Cleaning

1 In the CD window, double-click Install Spring Cleaning.

2 Double-click Spring Cleaning 5.0 Installer.

3 In the Welcome window, click Continue.
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4 Read the installation instructions, then click Continue.

5 To save the instructions, click Save.

6 To print the instructions, click Print.

7 In the Software License Agreement window, click Agree.
If you disagree, the installation is cancelled.

8 Click Install.

9 In the Select Location window, select the location in which to install 
Spring Cleaning.
If you do not want to install Spring Cleaning to the default location, 
navigate to another folder.

10 Click Install to finish the installation.

Now you are ready to use Spring Cleaning. See “Use Spring Cleaning” on 
page 131.

Uninstall Spring Cleaning

If you need to remove an installed version of Spring Cleaning from your 
computer, use the Norton SystemWorks for Macintosh CD Installer. The 
process is faster if all other programs are closed before you uninstall Spring 
Cleaning.

To uninstall Spring Cleaning

1 Follow steps 1-6 of the installation procedure.

2 On the pop-up menu, click Uninstall.

3 Check Standard Installation.

4 Click Uninstall.

5 Locate and select the Spring Cleaning 3.5.1 folder.

6 At the bottom of the window, click Select <folder name>.

7 Click Quit.

Use Spring Cleaning

Spring Cleaning performs searches to find files that you want to remove 
from your computer. It displays a list of files that you might want to 
remove, so that you can perform actions on individual items or groups of 
items. Such actions include deleting files and programs or moving them to 
a StuffIt archive or removable disk. You can return some items to their 
original locations using the Restore command.
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Spring Cleaning displays its 16 searches in the Search Type window. Each 
search finds items based on criteria that you specify. Each search serves a 
specific purpose and is described in detail in the User's Guide.

If there are items in the Trash that meet the search criteria, they appear in 
the Search Results window. Empty the Trash before performing a search.

To use Spring Cleaning 

1 In the Spring Cleaning folder on your disk, click Spring Cleaning.

2 In the Search Type window, select the search that you want to 
perform.
You may select only one search at a time.

3 Click Next.

4 If you have more than one disk or partition mounted, select the disks 
that you want to search.

5 Click Next.
Depending on the search that you selected, you may be prompted to 
provide additional information.
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Norton Disk Doctor 

messages
Norton Disk Doctor displays status and error messages when it encounters 
problems or issues during a disk examination. Some messages appear 
when Norton Disk Doctor is examining a disk in any Mac OS environment, 
and other messages are specific to Mac OS X file and disk operations. 

About Norton Disk Doctor messages

There are several types of messages in Norton Disk Doctor. In most cases, 
Norton Disk Doctor provides recommendations along with error messages. 
This section lists the most common messages, with general explanations.

Driver Descriptor Map and Partition Map messages

The Driver Descriptor Map and Partition Map structures contain 
information about the drivers that control a hard drive as well as a listing of 
the locations and sizes of the volumes on a drive.

The signature [block size / block count / driver count / driver start /

driver size /driver type] is invalid.

These problems can prevent volumes from being available.

No partitions found. 

The physical start block [signature / block count / logical data start / 

data count / partition type] is invalid [or incorrect].

These problems can prevent volumes from being available.
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Master Directory Block and Volume Header Block messages 

The Master Directory Block (MDB), located at sector 2 on an HFS-formatted 
volume, or the Volume Header Block (VHB) on an HFS Plus disk, contains 
essential bookkeeping information about a volume. This includes the 
number of files and folders on the disk, the amount of free disk space, the 
allocation block size, and the sizes and locations of such structures as the 
Volume Bitmap or Allocation File, the Catalog B-Tree, and the Extents B-
Tree.

While the MDB or VHB is a vital structure, it is modified frequently and 
damage is not uncommon. In most cases, Norton Disk Doctor can easily 
repair problems in these areas.

The most common MDB or VHB errors are identified by these messages:

Message Description

The Free block count is incorrect. This is commonly associated with errors in the 
Volume Bitmap or Allocation File, since these 
structures keep track of free blocks on a 
volume.

The contents of the allocation 
file/bitmap do not agree with the 
locations of all files as shown in 
the Catalog.

These problems should be repaired whenever 
they occur, as they can lead to file damage 
through cross-linked files.

The signature is incorrect.
The attributes are incorrect.
The creation date [or 
modification date] is invalid.

These messages usually indicate that the 
structure is damaged.

The total file count [total 
directory count] is incorrect.
The allocation block size [count 
of allocation blocks] is incorrect.

These messages indicate that the structure of 
the volume is incorrect and files might be 
inaccessible.

The next available file ID is 
incorrect.
The Extents [or Catalog] B-Tree 
clump size is invalid.
The physical size of the Extents 
[or Catalog] B-Tree is incorrect.
Invalid extents are specified for 
the Extents [or Catalog] B-Tree.

These messages might indicate that the 
directories have been damaged.
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B-Tree node messages

A B-Tree node is a sector or group of sectors in the Catalog or Extents B-
Tree. These sectors contain important data about files on a volume. The 
following messages indicate problems with nodes in any B-Tree. If you see 
one of the following messages, you might have found some files or folders 
to have been inaccessible. 

The node has an incorrect [forward link / backward link / type / depth 

/ record count]. 

The node is on an incorrect level.

The node has incorrect offsets.

These error messages indicate that there is damage to a disk directory.

B-Tree header messages

The B-Tree header nodes contain important information about the structure 
of the Catalog and Extents B-Trees, which contain information about the 
files on a volume. If you see one of the following messages, you might have 
found some files or folders to have been inaccessible.

The tree depth [node size / key length / tree attribute flags] is / are 

incorrect.

The number of nodes [free node count / tree bitmap / root node 

number / first leaf node number / last leaf node number / leaf record 

count / tree header structure] is incorrect.

These messages are caused by problems with any B-Tree header. They 
indicate damage to your disk directories and they might cause problems if 
you’re trying to mount a disk.

Catalog tree messages

The Catalog tree contains essential bookkeeping information, including the 
physical locations, names, and sizes of files and folders. It also contains 
data such as file types and creators, and the number of files contained by a 
folder. The following are Catalog tree messages.

General tree error.

When this error occurs, you might have seen a message that the disk 
cannot be mounted because it cannot be found.
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There is no root directory.

This error indicates that an important part of the Catalog B-Tree is damaged 
or missing.

Record messages.

This error indicates damage to your directories.

The record has an incorrect key length [incorrect key / incorrect 

length].

The record is out of order.

The record key is duplicated.

The leaf record has an incorrect type.

The index record has an incorrect downlink.

These errors can cause files to disappear or be inaccessible.

Catalog tree leaf node messages 

A leaf node is a node in the Catalog B-Tree or Extents B-Tree that contains 
file records or extents records. File records contain information about files 
that are stored on a disk, including their sizes, types and creators, 
attributes, and the physical locations of their data. Extents records contain 
the physical locations of those portions of fragmented files that are not 
tracked in the Catalog tree. The following are Catalog tree leaf node error 
messages.

The leaf record has an invalid name.

<filename> has a duplicated ID.

No thread record found for <filename>.

No parent directory found for <filename>.

The leaf record has an incorrect Parent ID.

These errors can cause files to disappear or folders to appear empty.

Catalog tree file record messages

The following are Catalog tree file record messages.

<filename> has an incorrect clump size [extent starting block number 

/extent length / data (or resource) starting block number / logical 

length / physical length].

<filename> has an empty extent descriptor.

These errors cause files to be damaged.
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Directory and file thread record messages

If you see directory and file thread record messages, it might mean that 
some folders might be empty or can’t be opened. File thread record errors 
are not as serious as directory thread records, but should be fixed. The 
following are directory and file thread record messages. 

Thread record <filename> has an invalid target Parent ID.

The thread record has an invalid target name.

Thread record <filename> has an invalid reserved byte.

No directory [or file] found for thread record <filename>.

The thread record does not point to its associated file [associated 

directory].

Thread record <filename> points to a file [or directory].

The file thread flag for <filename> is off but should be on [on but 

should be off].

These errors indicate that there is damage to a disk directory.

The thread record is unnecessarily large, and is wasting space.

This message does not indicate damage, but should be fixed.

Extents tree messages

The Extents B-Tree keeps track of extents (fragments) of fragmented files 
that are not stored in the Catalog B-Tree. The following are Extents tree 
messages.

The extent record does not match a known file.

The extent record has an invalid fork ID.

The extent record has an empty descriptor.

The extent record has an incorrect key [starting block number / block 

count].

These messages usually indicate that some files are damaged or lost.
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File messages

File errors affect only the files that are listed and do not otherwise affect the 
validity of the structures of your disk.

If System files are causing malfunctions or you suspect that they are 
causing problems, delete them. Damaged System files or applications 
might cause your computer’s operation to be affected. However, some files 
might contain irregularities that can cause Norton Disk Doctor to flag them 
as damaged, even when they are functioning normally. The following are 
file messages.

File messages Description

The files are crosslinked and might 
be damaged.

A cross-linked file shares at least part of its 
space on a disk with another file, which 
damages one or both files. Examine all files 
after fixing them. If the files cannot be fixed 
or are damaged, delete them from your disk.

The file names begin with a period. Many files use this convention, and you 
should not fix this problem if Norton Disk 
Doctor alerts you. 

The bundle bit is off, but should be 
on [on, but should be off].
The custom icon bit is off, but 
should be on [on, but should 
be off]. 

These types of messages might indicate that 
a file’s icon is incorrectly displayed in the 
Finder.

The file names contain a colon, 
which is an illegal character.
The files have damaged resource 
forks.
The files have bad creation dates 
[modification dates / backup dates].

Fixing these problems sets the incorrect date 
to match other correct dates or the current 
date in the file record.

The Finder information is incorrect. This indicates a corruption of the flags that 
control how the Finder displays a file.

The file names contain a NUL 
(ASCII zero) character.

The NUL character can’t be typed on the 
keyboard. 
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Hardlink messages

Hardlinks are used in Mac OS X to make files appear in more than one 
folder. A hardlink is similar to an alias. It lets the same file be accessed 
from multiple locations. Like UNIX, Mac OS X lets you create hardlinks to 
existing files.

When you create a hardlink, the following process occurs:

1 Your original file is renamed as inode###, where the ### symbols 
indicate a randomly generated ID.

1 This renamed file is moved to an invisible directory named HFS+ 
Private Data at the root of your drive.

1 Mac OS X creates hardlink files that use the original file’s name at 
your original file’s location and wherever you create a hardlink.
There is no limit to the number of hardlink files. The inode file keeps 
track of them all.

Opening a hardlink file is the same as opening the original file. If you delete 
a hardlink file, the system changes the hardlink count in the inode file. 
When you delete the last hardlink file, the count goes to zero, and the 
original file (the inode file) is also deleted.

Norton Disk Doctor displays the following messages if hardlink problems 
are found.

Message Description

No hardlink files 
reference the indirect 
files.

If no hardlink files to your original file (the inode file) 
exist, you can’t access your original file. This situation can 
arise if you accidentally delete hardlink files while your 
computer is started in Mac OS 9.x, or if there is directory 
corruption. Norton Disk Doctor repairs this by creating a 
new hardlink file for the inode. The new hardlink file is 
placed in the Lost and Found folder created by Norton Disk 
Doctor.

The indirect files have 
incorrect hardlink 
reference counts.

If the inode file's count of the number of hardlinks is 
incorrect, the Mac OS X Finder can experience trouble 
when it tries to keep track of the hardlinks. This situation 
can arise if you accidentally delete or duplicate hardlink 
files while your computer is started in Mac OS 9.x, or if a 
directory was corrupted. Norton Disk Doctor repairs this 
problem by adjusting the inode reference count to match 
the number of hardlinks that are found on the drive.
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No target files were 
found for the hardlink 
files.

If there is no target (inode) file for a hardlink, the hardlink 
has no data to access and is useless. This situation arises if 
you accidentally delete inode files while your computer is 
started in Mac OS 9.x, or if there is directory corruption. 
Norton Disk Doctor helps eliminate these useless files by 
letting you delete them.

The BSD mode for the 
files is incorrect. 

BSD flag bits help Mac OS X classify files and folders. In 
order for file hardlinks to work properly if the item is a file, 
the file being linked to must have its BSD mode properly 
set. This problem can arise through directory corruption 
and can prevent hardlinks from working. Norton Disk 
Doctor can fix this by resetting the BSD mode.

The current version of Mac OS X does not use the BSD file 
bit except when files are hardlinked, and so, for any 
nonhardlinked file, the file mode should be zero. The Mac 
OS X Finder can experience problems if the BSD mode is 
set to an invalid value. This problem can arise through 
directory corruption. Norton Disk Doctor can fix this by 
resetting the BSD mode.

Message Description



Using AppleScript 

with Norton 

AntiVirus
Norton AntiVirus for Macintosh lets you use your AppleScript to run 
certain features. To use this scriptable component, you must write an 
AppleScript script. Information on creating scripts is available on your 
Macintosh OS CD. AppleScript is not supported by Symantec Technical 
Support.

w Scripting is not available on Norton AntiVirus for Mac OS X. However, the 
Command Line Scanner can be called with UNIX shell scripts. 

Script commands

The following commands are available for use with Norton AntiVirus for 
Macintosh:

Script command Description

scan Scan the given files and folders for viruses.

load antivirus Load the Norton AntiVirus Library and Norton AntiVirus 
Macro Scan Lib.

unload antivirus Unload the Norton AntiVirus Library and the Norton 
AntiVirus Macro Scan Library.

get file of Extract the file object from a report object.

get viruses of Get the list of viruses that infect the file of the report.
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Within the scripting, you can cause Norton AntiVirus for Macintosh to 
display or hide its progress during scans. The script-initiated scan results, 
including the discovery and repair of infected files, can be saved in a text 
file. The Norton AntiVirus for Macintosh scriptable component does not 
handle compressed files.

get repaired status of Get the status of the repair from a given report.

Class scan result The result of a scan, including the total number of files 
scanned, and the reports of all irregular (damaged or 
infected) files.

Script command Description



Using Norton 

AntiVirus on a 

network
You can run Norton AntiVirus on any AppleTalk Transaction Protocol 
server such as AppleShare or TOPS.

Notes to the administrator

Set up Norton AntiVirus the following way in a networking environment:

1 Run Norton AntiVirus Auto-Protect and the Norton AntiVirus 
application on the system administrator’s computer. 

1 Make sure Norton AntiVirus Auto-Protect is run on all workstation 
Macintosh computers.

1 Use the Scheduler command from the Norton AntiVirus Tools menu to 
schedule periodic scans of all network drives.

Scanning network drives

When you are scanning network drives from a workstation, the server 
slows down for other users. If others are creating, deleting, or moving files 
on a network drive while Norton AntiVirus is scanning, all files may not get 
scanned. 

To prevent files from not getting scanned, do the following:

1 Make sure that you are the only one logged on to the server when 
scanning network drives.

1 Shut down the server, restart, reinstall Norton AntiVirus, and then 
perform the scan.
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Preparing an emergency response plan

To be fully prepared in case of a virus attack on a workstation, be sure to 
have a detailed emergency response plan written and distributed within 
your networking group before a problem arises. This maintains order and 
prevents panic in case of an infection.

Complete your plan based on the dynamics and needs of your organization.

Before a virus is detected

Conduct an informational meeting with your network users to discuss the 
basic nature and behavior of computer viruses. Stress that while having a 
computer virus on your system is reason to take immediate action, there is 
no need to panic. Emphasize that many viruses spread from illegal software 
copies, and prohibit the use of such software in your organization. Finally, 
explain how you’ve configured Norton AntiVirus to respond to a virus.

Instruct your users to:

1 Scan all software before using it. This includes programs downloaded 
from the Internet as well as new software.

1 Watch for warning signs such as frequent system crashes, lost data, 
screen interference, or suddenly unreliable programs.

1 Keep a current store of virus-free program backups.

1 Avoid running programs from unscanned removable media.

1 Write-protect removable media before using it in someone else’s 
computer.

To protect the workstations:

1 Scan each workstation to make sure that it is virus-free.

1 Train your users to use a file backup utility on a regular basis.

1 Train your users to update the virus definitions file when it becomes 
available. 
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To protect the network:

1 Password-protect all network executable directories so that only the 
administrator has write access to them. 

1 Scan for viruses on new and rented computers before using them.

1 Schedule periodic scans of all network servers.

1 If you are using Novell NetWare or Windows NT servers, use Norton 
AntiVirus Enterprise Solution components to protect servers from 
virus infections.

If a virus is detected

If a virus is detected on your network, remove it from all computers 
attached to the network.

To remove a virus

1 Physically disconnect the workstation from the network. 

2 Eradicate the virus on the workstation before reconnecting to the 
network.

3 Notify other users on the network to scan for viruses immediately.

4 Scan your network servers for viruses.
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Troubleshooting 

computer problems
For a comprehensive list of the latest troubleshooting tips, see the 
Symantec Service and Support Web site at:
www.symantec.com/techsupp/

If Norton SystemWorks cannot solve your problems

If Norton Disk Doctor, Volume Recover, and UnErase cannot solve your 
problems, try the following suggestions.

Suggestion For more information

Check all cables for loose connections. See “Check all cables” on 

page 150.

Reset the PRAM by restarting and pressing 
Command-Option-P-R.

See “Zap the PRAM (reset 

Parameter RAM)” on page 157.

Disconnect all external devices. See “Have you added anything 

new lately?” on page 151.

Update your device drivers with the latest 
formatting software. See the device manufacturer’s 
documentation.

See “Replace damaged System 

files” on page 158.

Your device might need an installed extension, or 
Norton Disk Doctor, UnErase, or Volume Recover 
might not recognize the device. 

See “If you don’t see the disk 

that you’re looking for” on 

page 100.
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Prepare your computer

Often, problems are easier to find and fix if you can first isolate the 
problem. Disconnect all external devices other than the one that you are 
examining. This saves time and prevents accidents from happening to 
trouble-free equipment.

w When you are troubleshooting, use an Apple keyboard and standard Apple 
mouse. Third-party input devices sometimes use custom drivers that are 
unavailable on the CD.

Check all cables

Your Macintosh or the hard disk might not be getting power, or they may 
not be communicating with each other properly due to a faulty cable 
connection.

Do the following to check your cables:

1 Start with the computer turned off. While it is turned off, check all of 
its power cords, peripheral cables, and connections. 

1 Make sure that your Macintosh and its peripherals are plugged into a 
grounded electrical outlet, and that they are connected to each other. If 
the computer is too close to a wall, the cable connectors might be loose 
or the cables might be crimped and the connection not properly made. 

1 If you are using a device that has a cable with the same type of 
connectors on each end, it might make a difference which end is 
connected to your Macintosh.

1 Do not substitute cables for different types of devices even if they look 
exactly alike. The wiring inside of the cable might be different.

1 If the computer doesn’t start, check the power strip or wall outlet with 
an item that is known to work.

1 When you are certain that power is available to all devices and that all 
connections are snug, turn the computer on. If your computer does not 
start, you might have a hardware problem. See “Is it a hardware 
problem?” on page 151.
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Have you added anything new lately?

The two top reasons for startup disk problems are adding a new external 
device and installing software that modifies your Mac OS System software. 

If your problem occurred right after you added a hard disk or other 
peripheral device, check for device conflicts.

w Sometimes removing certain kernel extensions can cause your Macintosh 
to freeze during startup. If this occurs, you may need to startup by holding 
the shift key down, which prevents third party kernel extensions from 
loading. The order in which you disable third party kernel extensions may 
also effect computer performance. It might be necessary to remove some 
kernel extensions and some startup items, and then restart.

Is it a hardware problem?

If you are having a hard disk problem that Norton Disk Doctor can’t fix, you 
might have a hardware problem. Compared to software problems, 
hardware failures are relatively uncommon. In the unlikely event that it 
happens, utility software can’t fix it, and you need to see a qualified 
technician.

Most internal or external hard disks display the following symptoms.

Type of drive Symptom

Internal and external 
drives

The access or busy LED might suddenly stop working or 
flash repeatedly. The sound that the hard disk makes 
when it spins up and recalibrates might have changed or 
gone away.

Sometimes drives experience a problem known as 
stiction. This is when the read/write assembly gets stuck 
to the point that the platter no longer spins. If the drive 
is external, sometimes a gentle thump can free it long 
enough for you to perform a backup. This procedure is 
not recommended nor is it a long-term solution. When 
you turn off the drive and turn it on again, the problem 
will probably return.
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When disks do not show up in a list

If a disk that you want to recover does not show up in a list while using 
Norton SystemWorks, there are a number of things you can do.

w Be careful not to accidentally erase or initialize your disk while attempting 
to solve this problem. 

External drives The power LED or the hard disk indicator light doesn’t 
light up. This can happen when the hard drive’s power 
supply fails. Your data might be intact on the disk. Have 
a technician investigate. 

Floppy disk drives and 
other removable media 
devices

Macintosh floppy disk drive heads can become dirty to 
the point that they no longer recognize an inserted 
floppy disk. Drive cleaning kits are not a complete 
solution to this problem. If you experience this problem, 
ask your technician if your drive can be cleaned. If a 
floppy disk gets stuck in a drive, take great care in 
removing it. The read/write head assembly is delicate 
and most damage that occurs here is not covered by the 
Apple warranty. 

Other removable media drives might require special 
cleaning procedures. Refer to your manufacturer’s 
instructions.

Type of drive Symptom

Possible Problem Action you can take

Information in your 
computer’s memory has 
interfered with disk 
recognition.

Restart your computer.

OS X does not recognize 
disk. 

Try booting into OS 9 on the same computer or a 
different computer. Double-click the Norton 
SystemWorks CD 9 partition of the CD.
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If all of these options prove unsuccessful, it’s quite possible that your drive 
is physically, mechanically, or electronically damaged. If you do not have a 
current backup copy, contact a data recovery service for consultation on 
what may be done to recover your data.

Damage to data structures 
on the physical disk 
prevents volumes from 
being located.

In the case where you have lost access to a single 
partition on a drive, you can start from the CD and 
run Volume Recover’s FileSaver Search on another 
partition. This may restore data structures on the 
physical disk and bring back the missing partition. 

See “Perform a FileSaver Search” on page 103.

If you are a data recovery expert, you can run Norton 
Disk Editor X to open the disk as a physical drive for 
examination. See the Norton Disk Editor X Reference 
Guide PDF on the CD.

Norton SystemWorks may 
not be installed correctly.

Uninstall the product and reinstall. 

See “Installation” on page 35.

Cable or port connection is 
faulty. 

Connect with a different cable and/or connect to 
different computer. This only applies if the disk that 
does not display in the list is external.

The port may not be 
supplying adequate power 
to run the disk. 

Connect to a different computer. Or, use an optional 
external power supply, if available. This only applies 
if the disk that does not display in the list is external.

The internal drive or 
internal cable is faulty.

Try removing and installing the drive into another 
computer.

The FireWire bridge or 
power supply of a drive has 
failed. 

Check with your FireWire drive’s vendor to see if 
your drive can be repaired with the data intact.

You may be able to remove the FireWire drive from 
its case and use it as a regular ATA drive (this may 
save you costly data recovery charges). Before 
considering this, check to see if the drive is still 
under warranty, as in most cases opening the case 
will void the warranty. 

Unidentified problem. Try using other available tools such as Apple’s Disk 
Utility.

Possible Problem Action you can take
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Problems with Norton AntiVirus

The problems discussed are not directly related to virus activity. If you 
cannot resolve your problem, consult the Read Me file on the Norton 
SystemWorks CD.

Norton AntiVirus Auto-Protect fails to load when I start my 

Macintosh

If Auto-Protect fails to load, make sure that all engine files and virus 
definitions are installed. Norton AntiVirus Auto-Protect does not run 
without them.

Norton AntiVirus reports that a file is invalid when trying to 

launch or scan, or at startup

This is an indication that one of the files making up the virus definitions is 
damaged or otherwise invalid.

To repair a damaged virus definitions file in Mac OS X

1 Uninstall Norton SystemWorks.

2 Reinstall Norton SystemWorks.

3 Run LiveUpdate and update your virus definitions. 
This restores the current versions of the items in the Norton AntiVirus 
Additions folder.

Norton AntiVirus cannot create an alias

If you did not install Norton SystemWorks, you cannot create an alias to it 
because of the access permissions established in Mac OS X. Have the 
person who installed the software create an alias and place the alias in an 
area to which you have access. You can then drag the alias to the location 
that you want.

Norton AntiVirus Messages

The following messages might be encountered when you are running 
Norton AntiVirus and Norton AntiVirus Auto-Protect.

Norton AntiVirus uses available memory to store items for the scan report. 
If you have many files, you will not be able to record all items to scan. You 
can change the Report Preferences to record infected files only.
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Auto-Protect error message

If you experience problems with the scan engine error message, you might 
still have incompatible files from a previous version of Norton AntiVirus for 
Macintosh. Uninstall and then reinstall Norton AntiVirus. 

Password and administrator messages

The entered subscription code is not valid. Please retype in the 9 
character subscription code again.

You entered a virus definitions subscription code incorrectly. Try typing 
the number again.

The passwords did not match. Please try again.

The second password you typed does not match the first one. 

That password is incorrect. Please try again.

You typed an incorrect password. If you forgot your password, see 
“Installation” on page 35.

The software to be installed requires Administrator or higher level 
access privileges. 

Enter your administrator password. 

Protection problems

A file on the disk may be damaged, or Norton SystemWorks ran out of 
memory, or some other error occurred during scanning. 

To determine if a file is causing the problem

1 Open Norton AntiVirus.

2 On the File View tab, click the drive triangle to display the folders 
inside. 

3 Scan the folders one at a time to determine where the problem is 
occurring.

4 Scan your disk again from the Norton AntiVirus main window. You 
may also want to examine the disk using a program such as Norton 
Disk Doctor (part of Norton Utilities for Macintosh).
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Scanning and account access privileges

Norton AntiVirus scans only those files for which your account has access 
privileges. If you ever log on and work as root, run the scan while logged on 
as root. If you do not log on as root, running the scan while logged on as an 
Administrator scans all files that could be infected while using that logon. If 
you do not want to see the list of files that could not be scanned because of 
denied access, check Do not list permissions errors when scanning in 
Preferences.

Rescan files that have already been scanned

The Norton AntiVirus QuickScan file records whether you have already 
scanned a file using the currently installed virus definitions and libraries. If 
not, the file is scanned. If you want all files to be scanned regardless, you 
can use Norton AntiVirus to delete the QuickScan file at the root of each 
disk. The file is named NAVMac800QSFile. 

To remove the QuickScan file

1 In the Norton AntiVirus window, on the File View tab, ensure that 
Show Invisible Files is checked.

2 Select your hard disk. 

3 Click the QuickScan file.
If there are QuickScan files from previous versions of Norton 
AntiVirus, select them as well.

4 Click Move To Trash.

5 Click OK.

6 Quit Norton AntiVirus. 

7 In the Finder, click Empty Trash.

After you have deleted the QuickScan file, the first scan with the new virus 
definitions will be slower.

Trouble updating virus definitions using LiveUpdate

In some rare cases such as immediately after the emergence of a new virus, 
the LiveUpdate servers may be very busy and it may be difficult to get a 
connection. In such cases, keep making connection attempts and you 
should eventually be successful.
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When using LiveUpdate, make sure that your Internet connection is 
working by testing the connection with an application, such as your Web 
browser.

Norton AntiVirus cannot find the Norton AntiVirus virus 

definitions file

Reinstall Norton SystemWorks.

Zap the PRAM (reset Parameter RAM)

The PRAM (Parameter RAM) is an area of RAM that is used to store 
information about your Macintosh. Your Macintosh computer needs part of 
the information that is stored in the PRAM in order to locate the current 
startup device. 

Because this information is needed each time that you use your Macintosh, 
it is stored even when your Macintosh is turned off (a battery supplies 
power to this memory when you shut down your Macintosh). If the 
information in the PRAM becomes corrupted, you can clear the information 
and replace it with new information.

w If your computer consistently does not retain the current date and time 
when you turn the computer off, your PRAM battery might need to be 
replaced.

Some System settings such as disk cache, mouse speed, menu blinking, 
time zone, and others must be reconfigured after you reset the PRAM. 

To reset the PRAM

1 Restart your computer while pressing Command, Option, P, and R.
As the computer begins to restart, you will hear the startup chime 
repeat. Continue pressing the keys until the chime has sounded three 
or more times. 

2 Release the keys and the startup should complete.
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Replace damaged System files

When you replace System files, you first need to perform a clean System 
install.

To replace System files

4 Using your Mac OS System CD, perform a clean System install.
Consult your Macintosh User’s Guide and follow the procedures for 
performing a clean System install.

Recover files before sending a disk to a technician

See “Before using 

UnErase” on 

page 108.

If you are still unable to start your Macintosh using your startup disk, you 
might have a hardware problem that only a qualified service technician can 
fix. It might still be possible to recover files from the volume even though 
you can’t start from it. Before you send the disk to a technician, try using 
UnErase to recover data. 

Reformat your hard disk

See “Using Norton 

Disk Editor” on 

page 159.

A hard disk can accumulate bad or weak sectors, known collectively as bad 
blocks. When this happens, some sectors can no longer be accessed unless 
the hard disk is physically reformatted or low-level formatted. 

Reformat your hard disk only if you have exhausted all repair options, 
including a professional data recovery service. Because reformatting the 
hard disk destroys all existing information that is contained on the disk, 
recover as much information as possible from your damaged volume before 
you begin reformatting. If you have a recent backup, recover only the new 
files and files that have changed since the last backup. 

Almost all hard disk formatting applications deal with bad blocks 
differently. Some remap the blocks using spare or unused sectors during 
the format process while others require that a specific procedure be run 
before or after formatting. For instructions on reformatting your hard disk, 
see the documentation that came with the formatting software.

w Do not format your hard disk unless you have a backup of the damaged 
hard disk or have successfully recovered all of the files using UnErase. 
See “Before using UnErase” on page 108.

More information is available in the Support section of the Symantec Web 
site. See “Service and support solutions” on page 161.
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Using Norton Disk Editor

Norton Disk Editor, a powerful program for advanced users, provides an 
alternative method of recovering data and repairing crashed disks. Use it 
only if you are unable to fix the problems using Norton SystemWorks tools.

w For more information, see the PDF documentation for Norton Disk Editor on 
your CD. Use Norton Disk Editor with extreme caution and at your own 
risk.
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Service and support 

solutions
The Service & Support Web site at http://service.symantec.com supports 
Symantec products. Customer Service helps with nontechnical issues such 
as orders, upgrades, replacements, and rebates. Technical Support helps 
with technical issues such as installing, configuring, or troubleshooting 
Symantec products.

Methods of technical support and customer service can vary by region. For 
information on support offerings in your region, check the appropriate Web 
site listed in the sections that follow.

If you received this product when you purchased your computer, your 
computer manufacturer may be responsible for providing your support.

Customer service
The Service & Support Web site at http://service.symantec.com tells you 
how to:

1 Subscribe to Symantec newsletters.

1 Locate resellers and consultants in your area.

1 Replace defective CD-ROMs and manuals.

1 Update your product registration.

1 Find out about orders, returns, or a rebate status.

1 Access Customer Service FAQs.

1 Post a question to a Customer Service representative.

1 Obtain product information, literature, or trialware.

For upgrade orders, visit the Symantec Store at: 
http://www.symantecstore.com
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Technical support
Symantec offers two technical support options for help with installing, 
configuring, or troubleshooting Symantec products:

1 Online Service and Support

Connect to the Symantec Service & Support Web site at
http://service.symantec.com, select your user type, and then select 
your product and version. You can access hot topics, Knowledge Base 
articles, tutorials, contact options, and more. You can also post a 
question to an online Technical Support representative.

1 PriorityCare telephone support

This fee-based (in most areas) telephone support is available to all 
registered customers. Find the phone number for your product at the 
Service & Support Web site. You’ll be led through the online options 
first, and then to the telephone contact options.

Support for old and discontinued versions

When Symantec announces that a product will no longer be marketed or 
sold, telephone support is discontinued 60 days later. Technical 
information may still be available through the Service & Support Web site 
at: 
http://service.symantec.com

Subscription policy
If your Symantec product includes virus, firewall, or Web content 
protection, you may be entitled to receive updates via LiveUpdate. 
Subscription length varies by Symantec product.

After your initial subscription ends, you must renew it before you can 
update your virus, firewall, or Web content protection. Without these 
updates, you will be vulnerable to attacks.

When you run LiveUpdate near the end of your subscription period, you are 
prompted to subscribe for a nominal charge. Simply follow the instructions 
on the screen. 

Worldwide service and support
Technical support and customer service solutions vary by country. For 
Symantec and International Partner locations outside of the United States, 
contact one of the service and support offices listed below, or connect to 
http://service.symantec.com and select your region under Global Service 
and Support.
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Service and support offices

Every effort has been made to ensure the accuracy of this information. 
However, the information contained herein is subject to change without 
notice. Symantec Corporation reserves the right for such change without 
prior notice.

April 2, 2003

North America

Symantec Corporation
555 International Way
Springfield, OR 97477
U.S.A.

http://www.symantec.com/

Australia and New Zealand

Symantec Australia
Level 2, 1 Julius Avenue
North Ryde, NSW 2113
Sydney
Australia

http://www.symantec.com/region/reg_ap/
+61 (2) 8879-1000
Fax: +61 (2) 8879-1001

Europe, Middle East, and Africa

Symantec Authorized Service Center
Postbus 1029
3600 BA Maarssen,
The Netherlands

http://www.symantec.com/region/reg_eu/
+353 (1) 811 8032

Latin America

Symantec Brasil
Market Place Tower
Av. Dr. Chucri Zaidan, 920
12  andar
São Paulo - SP
CEP: 04583-904
Brasil, SA

Portuguese: 
http://www.service.symantec.com/br
Spanish:
http://www.service.symantec.com/mx
Brazil: +55 (11) 5189-6300
Mexico: +52 55 5322 3681 (Mexico DF)
01 800 711 8443 (Interior)
Argentina: +54 (11) 5382-3802
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Aladdin Systems 

technical support
The User's Guide should answer all of your questions. There is also online 
technical support help at www.aladdinsys.com/support

Registering Spring Cleaning and iClean

Free technical support is available to all registered users, so be sure to 
register your copy of Spring Cleaning and iClean. After registering, you will 
be notified of upgrades, new products, and special offers from Aladdin.

There are four ways to register:

1 Register online at www.aladdinsys.com/register/index.html

1 On the iClean iSupport menu, click Software Registration.

1 Fill out the postage-paid registration card and mail it to Aladdin.

1 Call Aladdin customer service at (831) 761-6200.

Requesting technical support

Registered users may also contact Aladdin technical support via our online 
support service, phone, fax, or mail. Please be sure to have the following 
information available prior to calling, or include it in your email, fax, or 
letter.

Write down your questions or have a clear idea of the problem.

Be prepared to duplicate the problem. Write down the steps you took that 
caused the problem.
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Be prepared to give the following information:

1 Any error messages

1 Your computer model

1 Your Mac OS version (system version)

1 The amount of RAM installed on your machine

1 Your Spring Cleaning or iClean version number and registration 
number

Contacting Aladdin Systems

You can contact Aladdin Systems through the Internet, by fax, by phone, or 
through the postal system.

Web www.aladdinsys.com/support

email service@aladdinsys.com

Fax (831) 761-6206

Phone (831) 761-6200

Mail Aladdin Systems, Inc.
245 Westridge Drive
Watsonville, CA 95076



Dantz Development 

Corporation 

technical support 
For information on technical support options, please call Dantz at 800-225-
4880, or visit the Dantz Web site: www.dantz.com/support

Customers outside the United States, Canada, and Latin America should 
contact technical support as detailed below or visit the Dantz Web site to 
find contact information for the authorized distributor in your area.

1 United Kingdom:
Phone: +0800 169 77 64
Fax: +33 1 55 33 02 09
Email: eurosupport@dantz.com

1 All other European countries:
Phone: +33 1 55 33 02 10
Fax: +33 1 55 33 02 09
Email: eurosupport@dantz.com

1 United States and rest of world:
Standard Technical Support:
Phone: 925 253 3050
Fax: 925 253 9099
Email: customerservice@dantz.com

http://www.dantz.com/index.php3?SCREEN=service_and_support
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Contacting Dantz Development Corporation

1 North America
4 Orinda Way, Building C
Orinda, CA 94563 USA
Phone: 925 253 3000
Fax: 925 253 9099
info@dantz.com (automated response)
customer_service@dantz.com
www.dantz.com

1 Dantz Europe
77, rue du Faubourg St-Denis
75010 Paris - France
Phone: +33 1 55 33 02 00
Fax: +33 1 55 33 02 09
europe@dantz.com



Glossary
access privileges The types of operations that a user can perform on a 
system resource. For example, a user can have the 
ability to access a certain directory and open, modify, 
or delete its contents.

ActiveSync The synchronization software for Microsoft 
Windows-based Pocket PCs.

ActiveX A method of embedding interactive programs into 
Web pages. The programs, which are called controls, 
run when you view the page.

alert A message that appears to signal that an error has 
occurred or that there is a task that requires 
immediate attention, such as a system crash or a 
Virus Alert.

alias A shortcut icon that points to an original object such 
as a file, folder, or disk.

AppleTalk A protocol that is used by some network devices 
such as printers and servers to communicate.

attack signature A data pattern that is characteristic of an Internet 
attack. Intrusion Detection uses attack signatures to 
distinguish attacks from legitimate traffic.

beam To transfer certain programs and data between two 
handheld devices using built-in infrared technology.
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boot record A sector at the start of a disk that describes the disk 
(sector size, cluster size, and so on). On startup 
disks, the boot record also has a program that loads 
the operating system.

bootable disk A disk that can be used to start a computer.

cache A location on your disk in which data is stored for 
reuse. A Web browser cache stores Web pages and 
files (such as graphics) as you view them. 

cache file A file that is used to improve the performance of 
Windows. 

compressed file A file whose content has been made smaller so that 
the resulting data occupies less physical space on 
the disk.

connection-based 
protocol

A protocol that requires a connection before 
information packets are transmitted.

connectionless 
protocol

A protocol that sends a transmission to a destination 
address on a network without establishing a 
connection.

cookie A file that some Web servers put on your disk when 
you view pages from those servers. Cookies store 
preferences, create online shopping carts, and 
identify repeat visitors.

denial-of-service 
attack

A user or program that takes up all of the system 
resources by launching a multitude of requests, 
leaving no resources, and thereby denying service to 
other users.

DHCP (Dynamic 
Host Configuration 
Protocol)

A TCP/IP protocol that assigns a temporary IP 
address to each device on a network. DSL and cable 
routers use DHCP to allow multiple computers to 
share a single Internet connection.

dial-up A connection in which a computer calls a server and 
operates as a local workstation on the network.

DNS (Domain Name 
System)

The naming system used on the Internet. DNS 
translates domain names (such as 
www.symantec.com) into IP addresses that 
computers understand (such as 206.204.212.71). 



Glossary 171
DNS server 
(Domain Name 
System server)

A computer that maps domain names to IP 
addresses. When you visit www.symantec.com, your 
computer contacts a DNS server that translates the 
domain name into an IP address (206.204.212.71).

domain The common Internet address for a single company 
or organization (such as symantec.com). See also 
host name.

DOS window A method of accessing the MS-DOS operating system 
to execute DOS programs through the Windows 
graphical environment.

download To transfer a copy of a file or program from the 
Internet, a server, or computer system to another 
server or computer.

driver Software instructions for interpreting commands for 
transfer to and from peripheral devices and a 
computer.

encryption Encoding data in such a way that only a person with 
the correct password or cryptographic key can read 
it. This prevents unauthorized users from viewing or 
tampering with the data.

Ethernet A common method of networking computers in a 
LAN (local area network). Ethernet cables, which 
look like oversized phone cables, carry data at 10M 
bps or 100M bps.

executable file A file containing program code that can be run. 
Generally includes any file that is a program, 
extension, or system files whose names end with 
.bat, .exe, or .com.

extension The three-letter ending on a file name that associates 
the file with an activity or program. Examples 
include .txt (text) and .exe (executable program).

FAT (file allocation 
table)

A system table (used primarily by DOS and Windows 
9x/Me) that organizes the exact location of the files 
on the hard drive.

file type A code that associates the file with a program or 
activity, often appearing as the file name extension, 
such as .txt or .jpeg.
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Finder The program that manages your Macintosh disk and 
file activity and display.

firewall rule Parameters that define how a firewall reacts to 
specific data or network communications. A firewall 
rule usually contains a data pattern and an action to 
take if the pattern is found.

fragmented When the data that makes up a file is stored in 
noncontiguous clusters across a disk. A fragmented 
file takes longer to read from the disk than an 
unfragmented file.

fragmented IP 
packet

An IP packet that has been split into parts. Packets 
are fragmented if they exceed a network's maximum 
packet size, but malicious users also fragment them 
to hide Internet attacks.

FTP (File Transfer 
Protocol)

An application protocol used for transferring files 
between computers over TCP/IP networks such as 
the Internet.

hidden attribute A file attribute that makes files harder to access and 
more difficult to delete than other files. It also 
prevents them from appearing in a DOS or Windows 
directory list.

host name The name by which most users refer to a Web site. 
For example, www.symantec.com is the host name 
for the Symantec Web site. Host names are 
translated to IP addresses by the DNS.

HotSync The synchronization software for Palm OS handheld 
devices.

HTML (Hypertext 
Markup Language)

The language used to create Web pages.

ICMP (Internet 
Control Message 
Protocol)

An extension to the basic Internet Protocol (IP) that 
provides feedback about network problems.

IGMP (Internet 
Group 
Management 
Protocol) 

An extension to the basic Internet Protocol (IP) that 
is used to broadcast multimedia over the Internet.
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IMAP4 (Internet 
Message Access 
Protocol version 4)

One of the two most popular protocols for receiving 
email. IMAP makes messages available to read and 
manage without downloading them to your 
computer.

infrared (IR) port A communication port on a handheld device for 
interfacing with an infrared-capable device. Infrared 
ports do not use cables.

IP (Internet 
Protocol)

The protocol that underlies most Internet traffic. IP 
determines how data flows from one computer to 
another. Computers on the Internet have IP 
addresses that uniquely identify them.

IP address 
(Internet Protocol 
address) 

A numeric identifier that uniquely identifies a 
computer on the Internet. IP addresses are usually 
shown as four groups of numbers separated by 
periods. For example, 206.204.52.71.

ISP (Internet 
service provider) 

A company that supplies Internet access to 
individuals and companies. Most ISPs offer 
additional Internet connectivity services, such as 
Web site hosting. 

Java A programming language used to create small 
programs called applets. Java applets can be used to 
create interactive content on Web pages.

JavaScript A scripting language used to enhance Web pages. 
Most sites use JavaScript to add simple interactivity 
to pages, but some use it to open pop-up ads and 
reset visitors' homepages.

macro A simple software program that can be started by a 
specific keystroke or a series of keystrokes. Macros 
can be used to automate repetitive tasks.

NAT (network 
address 
translation) 

A method of mapping private IP addresses to a single 
public IP address. NAT allows multiple computers to 
share a single public IP address. Most DSL and cable 
routers support NAT.

network address The portion of an IP address that is shared by all 
computers on a network or subnet. For example, 
10.0.1.1 and 10.0.1.8 are part of the network address 
10.0.1.0.
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NTFS (NTFS file 
system)

A system table (used primarily by Windows 2000/
XP) that organizes the exact location of all the files 
on the hard drive.

packet The basic unit of data on the Internet. Along with the 
data, each packet includes a header that describes 
the packet's destination and how the data should be 
processed.

partition A portion of a disk that is prepared and set aside by 
a special disk utility to function as a separate disk. 

POP3 (Post Office 
Protocol version 3)

One of the two most popular protocols for receiving 
email. POP3 requires that you download messages to 
read them.

port A connection between two computers. TCP/IP and 
UDP use ports to indicate the type of server program 
that should handle a connection. Each port is 
identified by a number.

port number A number used to identify a particular Internet 
service. Internet packets include the port number to 
help recipient computers decide which program 
should handle the data.

PPP (Point-to-
Point Protocol)

A protocol for communication between two 
computers using a dial-up connection. PPP provides 
error-checking features.

protocol A set of rules governing the communication and 
transfer of data between computers. Examples of 
protocols include HTTP and FTP.

proxy A computer or program that redirects incoming and 
outgoing traffic between computers or networks. 
Proxies are often used to protect computers and 
networks from outside threats.

registry A category of data stored in the Windows registry 
that describes user preferences, hardware settings, 
and other configuration information. Registry data is 
accessed using registry keys. 

removable media Disks that can be removed, as opposed to those that 
cannot. Some examples of removable media are 
floppy disks, CDs, DVDs, and Zip disks. 
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router A device that forwards information between 
computers and networks. Routers are used to 
manage the paths that data takes over a network. 
Many cable and DSL modems include routers.

script A program, written in a scripting language such as 
VBScript or JavaScript, that consists of a set of 
instructions that can run without user interaction. 

service General term for the process of offering information 
access to other computers. Common services include 
Web service and FTP service. Computers offering 
services are called servers.

SSL (Secure Sockets 
Layer)

A protocol for secure online communication. 
Messages sent using SSL are encrypted to prevent 
unauthorized viewing. SSL is often used to protect 
financial information.

subnet A local area network that is part of a larger intranet 
or the Internet. 

subnet mask A code, in the form of an IP address, that computers 
use to determine which part of an IP address 
identifies the subnet and which part identifies an 
individual computer on that subnet.

synchronize The process by which a handheld device and 
computer compare files to ensure that they contain 
the same data.

sync The process of transferring programs and data from 
a computer to a handheld device.

TCP/IP 
(Transmission 
Control Protocol/
Internet Protocol) 

Standard protocols used for most Internet 
communication. TCP establishes connections 
between computers and verifies that data is properly 
received. IP determines how the data is routed.

threat A program with the potential to cause damage to a 
computer by destruction, disclosure, modification of 
data, or denial of service. 

Trojan horse A program containing malicious code that is 
disguised as or hiding in something benign, such as 
a game or utility.
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UDP (User 
Datagram 
Protocol)

A protocol commonly used for streaming media. 
Unlike TCP, UDP does not establish a connection 
before sending data and it does not verify that the 
data is properly received.

virus definition Virus information that an antivirus program uses to 
identify and alert you to the presence of a specific 
virus. 

wildcard 
characters

Special characters (like *, $, and ?) that act as 
placeholders for one or more characters. Wildcards 
let you match several items with a single 
specification.

worm A program that replicates without infecting other 
programs. Some worms spread by copying 
themselves from disk to disk, while others replicate 
only in memory to slow a computer down. So far, 
worms do not exist in the Macintosh world.
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Norton SystemWorks™ for Macintosh®
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FOR CD REPLACEMENT
Please send me:    ______ CD Replacement
Name _____________________________________________________________________________________________
Company Name _____________________________________________________________________________________
Street Address (No P.O. Boxes, Please) _________________________________________________________________
City _______________________________________ State _______ Zip/Postal Code _________________________
Country* ____________________ Daytime Phone ______________________________________________________
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*This offer limited to U.S., Canada, and Mexico. Outside North America, contact your local Symantec office or 
distributor.
Briefly describe the problem: _________________________________________________________________________

FORM OF PAYMENT ** (Check One):
___  Check (Payable to Symantec)  Amount Enclosed  $ __________ _____Visa ____ Mastercard ____  AMEX
Credit Card Number ______________________________Expires _________________________________________
Name on Card (please print) _______________________ Signature  ______________________________________
**U.S. Dollars. Payment must be made in U.S. dollars drawn on a U.S. bank.

MAIL YOUR CD REPLACEMENT ORDER TO:
Symantec Corporation
Attention:  Order Processing
555 International Way
Springfield, OR 97477 (800) 441-7234
Please allow 2-3 weeks for delivery within the U.S.
Symantec and Norton SystemWorks are trademarks of Symantec Corporation.
Other brands and products are trademarks of their respective holder/s.
© 2003 Symantec Corporation. All rights reserved. Printed in the U.S.A.

CD REPLACEMENT: After your 60-Day Limited Warranty, if your CD becomes unusable, fill out and return 1) this form, 2) your damaged 
CD, and 3) your payment (see pricing below, add sales tax if applicable), to the address below to receive replacement CD. DURING THE 
60-DAY LIMITED WARRANTY PERIOD, THIS SERVICE IS FREE.  You must be a registered customer in order to receive CD replacements.

If your Symantec product was installed on your computer when you purchased it, contact your hardware manufacturer for CD 
replacement information.

CD Replacement Price   $ 10.00
Sales Tax (See Table) ______
Shipping & Handling $   9.95

TOTAL DUE ______

SALES TAX TABLE: AZ (5%), CA (7.25%), CO (3%), CT (6%), DC (5.75%), FL (6%), GA 
(4%), IA (5%), IL (6.25%), IN (5%), KS (4.9%), LA (4%), MA (5%), MD (5%), ME (6%), MI 
(6%), MN (6.5%), MO (4.225%), NC (6%), NJ (6%), NY (4%), OH (5%), OK (4.5%), PA (6%), 
SC (5%), TN (6%), TX (6.25%), VA (4.5%), WA (6.5%), WI (5%). 
Please add local sales tax (as well as state sales tax) in AZ, CA, FL, GA, MO, NY, OH, OK, 
SC, TN, TX, WA, WI. 
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